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Thank You for Choosing Ross
You've made a great choice. We expect you will be very happy with your purchase of Ross Technology. 

Our mission is to:

1. Provide a Superior Customer Experience

• offer the best product quality and support

2. Make Cool Practical Technology

• develop great products that customers love

Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and 
empowers our employees. I hope you enjoy reading it below.

If anything at all with your Ross experience does not live up to your expectations be sure to reach out to 
us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics

Any company is the sum total of the people that make things happen. At Ross, our employees are a 
special group. Our employees truly care about doing a great job and delivering a high quality customer 
experience every day. This code of ethics hangs on the wall of all Ross Video locations to guide our 
behavior:

1. We will always act in our customers’ best interest.

2. We will do our best to understand our customers’ requirements.

3. We will not ship crap.

4. We will be great to work with.

5. We will do something extra for our customers, as an apology, when something big goes wrong and 
it's our fault.

6. We will keep our promises.

7. We will treat the competition with respect.

8. We will cooperate with and help other friendly companies.

9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in 
times of company or customer crisis - do what you know in your heart is right. (You may rent 
helicopters if necessary.)
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Introduction
This chapter contains the following sections:
• “Overview”
• “Documentation Conventions”
• “Contacting Technical Support”

Overview

The PTZ Camera Control plugin is a DashBoard application that enables you to configure and control 
supported PTZ cameras such as Ross Video’s PTZ-12G and PTZ-NDI cameras. You can control cameras 
manually, store and recall presets, and configure camera settings.

This manual describes how to use the PTZ Camera Control plugin to operate PTZ cameras.

Documentation Conventions

Special text formats are used in this manual to identify parts of the user interface, text that a user must 
enter, or a sequence of menus and submenus that must be followed to reach a particular command.

Interface Elements
Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For 
example:

On the Manage Deleted presets page, tap the ALL BANKS tab to view all deleted presets.

Touch-Screen Support
This guide assumes you are using a touch-screen. The guide includes instructions to tap user interface 
elements. If you are using a mouse instead of a touch screen, click the mouse instead of tapping.

User-Typed Text
Courier text is used to identify text that a user must type. For example:

In the File Name box, type Channel02.property.

Referenced Guides
Italic text is used to identify the titles of referenced guides, manuals, or documents. For example:

User Manual for PTZ Camera Control Plugin (8351DR-015-xx)

Menu Sequences
Menu arrows are used in procedures to identify a sequence of menu items that you must follow. For 
example, if a step reads “Server > Save As,” you would tap the Server menu and then tap Save As.
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Contacting Technical Support

At Ross Video, we take pride in the quality of our products, but if problems occur, help is as close as the 
nearest telephone.

Our 24-hour Hot Line service ensures you have access to technical expertise around the clock. After-sales 
service and technical support is provided directly by Ross Video personnel.

During business hours (Eastern time), technical support personnel are available by telephone any time. 
Emergency after hours calls are answered by an answering service (live person) who will patch your call 
to the on-call support specialist. In the event that the on-call person is assisting another customer, the 
answering service will contact the back-up support specialist. 

Our team of highly trained staff is available to react to any problem and to do whatever is necessary to 
ensure customer satisfaction.

• Toll Free Technical Support 24/7: 1-844-652-0645 (North America), or +800 1005 0100 (International)
• Technical Support: (+1) 613-652-4886
• E-mail for Technical Support: techsupport@rossvideo.com 
• ROSS VIDEO | HELP CENTER: https://support.rossvideo.com/hc/en-us
• E-mail for General Information: solutions@rossvideo.com
• Ross Video Website: http://www.rossvideo.com

mailto:techsupport@rossvideo.com
mailto:solutions@rossvideo.com
https://support.rossvideo.com/hc/en-us 
http://www.rossvideo.com
http://www.rossvideo.com
https://support.rossvideo.com/hc/en-us 
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System Setup
This section describes how to set up a PTZ Camera Control system.

Complete the following major tasks, in the order presented:
• “Install Cameras”
• “Install DashBoard Software”
• “Add Cameras to DashBoard”
• “Establish Bank Structure (Rebuild Banks)”
• “Specify Where Presets are Stored, and from Where they are Recalled”

After you complete the tasks listed above, you can customize the configuration for each camera. For 
information about configuration settings, see “Configuration Settings and On-Screen Menu”.

Install Cameras

Before you can use the PTZ Camera Control plugin to control your cameras, they must be securely 
mounted, cabled, and turned on.

Configure each camera to have a unique IP addresses. All PTZ cameras must be accessible by the PTZ 
Camera Control computer over the IP network. For more information about configuring IP addresses for 
the cameras, refer to the documentation that came with them.

DashBoard supported PTZ Cameras include:
• Ross Video PTZ-12G+, PTZ-12G, and PTZ-NDI
• PIVOTCam-SE
• Sony BRC-H900, BRC-X1000, ILME-FR7, and BRC-AM7
• Panasonic AW-UE150. AW-UE160, and AW-HR140
• Lumens VC-A71P and VC-A71PN
• Canon CR-N300, CR-N500, and CR-X300
Note: The Sony ILME-FR7 and BRC-AM7 both feature a physical Setup switch that must be turned ON 
to enable remote VISCA control via DashBoard. Refer to the camera’s user manual for the exact switch 
location and configuration procedure.

Install DashBoard Software

Install the latest version of the DashBoard Control System application on the PTZ Camera Control 
computer. The PTZ Camera Control plugin is automatically installed as part of DashBoard.

DashBoard and the DashBoard User Guide are available as free downloads from Ross Video. The 
DashBoard User Guide contains instructions for installing DashBoard. Both are available at the following 
location:

https://www.rossvideo.com/products-services/management-systems/automated-production-control/dashboa
rd/

Add Cameras to DashBoard

Add each camera as a device in DashBoard.

https://www.rossvideo.com/products-services/management-systems/automated-production-control/dashboard/
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Control of Ross Video PTZ cameras is free and requires no software license. If you are using one or more 
third-party cameras, such as Sony BRC cameras or Panasonic PTZ cameras, you will require a license key 
code from Ross Video. Because the key code is a response to a prompt that appears while you are adding 
the first camera, the key code cannot be obtained in advance. Be prepared to contact Ross Video 
Technical Support when you add the first camera. For third-party Software Based Licensing or Ross 
Key Based Licensing, refer to “To add a camera:”.

Note: PTZ-12G+, PTZ-12G, and PTZ-NDI cameras, PIVOTCam-SE cameras, Sony PTZ cameras, Canon PTZ 
cameras, and Lumens  PTZ cameras communicate with DashBoard via UDP through port 52381 on the 
DashBoard computer. If you are using these types of cameras, ensure that port 52381 is accessible and is 
not blocked by a firewall application.

Note: When adding a Panasonic PTZ camera with user authentication enabled, it is recommended to 
disable authentication on the camera before adding it to DashBoard. Once the camera has been 
successfully added, you can configure the username and password in DashBoard, then re-enable 
authentication on the camera. Refer to Configuring Authentication (Panasonic Cameras Only).
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To add a camera:

1. On the PTZ Camera Control computer, open DashBoard.
2. From the File menu, tap New, and then tap Other.

The New dialog box appears.
3. Expand the Cameras node, tap PTZ Camera, and then tap Next.

The New PTZ Cameras Connection dialog box appears (Figure 1).

Figure 1 - The New PTZ Cameras Connection dialog box

4. In the IP Address box, type the IP address of the camera.
5. In the Display Name box, type the name of the camera, as you want it to appear in DashBoard.
6. In the Model list, select the model of the camera.

Note: For Panasonic PTZ cameras with user authentication enabled, it is recommended to 
disable authentication on the camera before adding it to DashBoard. Once added, you can enter 
the required credentials in DashBoard and then re-enable authentication on the camera.

7. In the Slot box, select or type a slot number (1 or higher) to specify the order in which the camera is 
to be listed in the DashBoard tree.
Tip: If you do not specify a slot number, or if you specify one that is already in use, the camera is 
assigned the lowest available slot number.

Note: When adding a Panasonic AW-UE150, AW-UE160, or AW-HR140 PTZ camera, for DashBoard v9.8 or 
higher, a Port box appears. The default port is 80. Refer to (Figure 2).
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Figure 2 - Connecting a Panasonic AW-UE150 PTZ camera in DashBoard

The port value should be set to match the value configured on the camera. DashBoard connects to the 
provided port when selecting Finish.

8. Tap Finish.
The camera should appear in the DashBoard tree, within the PTZ Cameras node (Figure 3).

Figure 3 - The PTZ Cameras node in the DashBoard tree

9. If the camera fails to appear in the DashBoard tree, or appears with a red dot, do the following:

a. Ensure that power is connected to the camera, and that the cameras is turned ON.

b. Check the IP address you typed in Step 4 and ensure that it matches the IP address of the 
camera.

c. Ensure that no other application on the computer is already connected to, or trying to connect to, 
the camera (for example, another instance of DashBoard).

Tip: If an instance of DashBoard is already connected to the camera, the following error message 
may appear:

Error - unable to bind to UDP port for camera
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10. Integrating a third-party camera with DashBoard necessitates license activation. DashBoard 
supports two licensing options: Software-Based Licensing and Ross Key Based Licensing.

Software-based licensing involves connection of DashBoard to the Ross activation server either 
directly or via a Ross Product Manager licensing server on prem. To use software-based licensing, 
you will need a product key provided by Ross.

Ross Key Based Licensing is a fixed license tied to your hardware. During the licensing process you 
will need to send a key code to Ross technical support who will return a license key for you to enter 
into DashBoard.

For more information, refer to the DashBoard User Guide 8351DR-004-XX.

Note: Product key packs do not require a hardware request code but does require an RPM sever or 
access to the Activation server.

For activating DashBoard licensed features, refer to the following procedures:

To update DashBoard licensed features (Software Based Licensing method)

a. From the main toolbar, select Window > Preferences. Refer to Figure 4.

Figure 4 - DashBoard Licensed Features - Software Based Licensing tab

b. The Preferences dialog box opens.

c. From the Preferences dialog box, select Licensed Features.

d. In the Licensed Features dialog box, ensure the Software Based License tab is selected.

e. Select the Server type that you are using to provide licensing.

f. If you are using the Ross Platform Manager server type, enter the Host Name and Port of the 
server and whether to Use HTTPS connection. 
Note: Select Apply to save your server settings.
Note: Use the Test Connection button to confirm a successful connection if necessary.

g. Once connection to the server is established, select Add and enter the product key provided to 
you.
If successful, the feature you added will appear in the Licensed Features table.
Note: Select Apply to confirm your changes.
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To update DashBoard licensed features (Ross Keys Based Licensing method)
For obtaining and entering a Ross licensing key code, complete the following:

a. From the main toolbar, select Window > Preferences. Refer to Figure 5.

Figure 5 - DashBoard Licensed Features - Ross Key Based Licensing tab

b. The Preferences dialog box opens.

c. From the Preferences dialog box, select Licensed Features.

d. In the Licensed Features dialog box, ensure the Ross Key Based License tab is selected.

e. From either the Active or Available subfolder, select the feature you want to update.

f. To obtain a Ross License Key by completing the following:

i.    Click Install/Update License.
ii.   The Enter License Key dialog box opens. Refer to Figure 6.

Figure 6 - DashBoard Licensed Features - Enter License Key

iii.    Select Copy to Clipboard to copy your request code.

iv.   Paste the request code into an e-mail to Ross Video (techsupport@rossvideo.com), 
requesting a corresponding license key. Be sure to include the original Ross Video sales order 
number. 
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CAUTION: Do not close the Enter License Key dialog box until you receive and apply an 
activation code from Ross Video. If you leave the Enter License Key dialog box, the activation 
code you receive will not work. It is valid only for the session during which it was generated.
v.     When you receive the license key via email, copy and paste it into the License Key box, and 
then tap Install.
vi.   The selected feature updates and the most current data is displayed in the License Details.

11. If the camera is ceiling-mounted (inverted), we recommend you turn On the Image Flip and 
Image Mirror options (also known as Ceiling Mount for some cameras) before you create any 
presets. Changing these settings after presets exist renders the presets useless.
The Image Flip and Image Mirror options are available in the PTZ Camera Control plugin at Config > 
Camera > Camera Options.

For more information, see “Image Flip and Image Mirror”.

Establish Bank Structure (Rebuild Banks)

A bank is a grid of preset buttons, each of which represents a camera preset. The PTZ Camera Control 
plugin can store multiple banks of preset buttons. You can configure the banks to suit your 
requirements.

For each camera, it is important to establish the structure of its banks (rebuild banks) BEFORE you start 
storing presets, because rebuilding banks requires all presets to be permanently discarded.

For information about establishing the bank structure for a camera, see “Rebuild Banks”.

Note: If you intend to configure a camera by importing a camera settings (.camera) file, rebuilding banks 
does not apply. The bank structure is imported as part of the camera settings file. For more information 
about importing camera settings, see “Load (Import) Banks, Presets, and Camera Settings (.camera 
file)”.

Specify Where Presets are Stored, and from Where they 
are Recalled

You can specify whether presets stored by the PTZ Camera Control plugin are stored in local memory 
AND in the camera’s memory, or only in local memory. You can also specify whether the PTZ Camera 
Control plugin recalls presets from local memory or from the camera’s memory.

By default, the PTZ Camera Control plugin does not store presets on the camera, and recalls them from 
local memory only.

Note: For Canon PTZ cameras, presets can only be stored in the camera's memory. The DashBoard 
computer does not support local memory storage.
We recommend you configure these settings before creating presets:
• The setting to specify whether presets are stored locally is in the Interface area of the Config page 

(Config > Operation > Interface > Store Presets on Camera).
• The setting to specify whether presets are recalled from local memory or from the camera’s memory is 

in the Interface area of the Config page (Config > Operation > Interface > Recall Presets From).
• The setting to specify whether DashBoard will recall presets from camera memory even when no 

preset is stored locally (Blind Recall). 

For more information, see “Operation Settings Page”.
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PTZ, Iris, and Focus Controls
This section contains topics about controls that are available on the PTZ page:
• “Pan/Tilt Controls”
• “Zoom Controls”
• “Iris Controls”
• “Focus Controls”

Note: Some features described in this section are not available on all cameras. The selection of features 
and the appearance of the interface may vary between camera models. Unless stated otherwise, figures 
and feature descriptions in this section describe the interface as it appears for Ross Video PTZ-12G+, 
PTZ-12G, and PTZ-NDI cameras. For information about controls for other camera types, refer to the user 
manuals for those cameras.

To access the PTZ page:

• Tap the PTZ button.
If a message about enabling joystick control appears, click the Enable Joystick Control button.
The PTZ page appears (Figure 7).

Figure 7 - Pan/Tilt controls and Iris/Zoom/Focus controls
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Pan/Tilt Controls

Figure 8 - Pan/Tilt controls

To pan and/or tilt the camera, do one of the following:

• Tap and drag the cross-hairs away from center. The farther the cross-hairs are from center, the faster 
the camera moves.

• Tap and drag either the pan slider or the tilt slider away from center. The farther the slider handle is 
from center, the faster the camera moves.

Zoom Controls
This section describes zoom controls as they appear for PTZ-12G+, PTZ-12G, and PTZ-NDI cameras. Zoom 
controls vary by camera model. Some do not have digital zoom controls. Others have an On/Off setting 
for digital zoom.

Figure 9 - Zoom controls
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To adjust the Digital Zoom Limit (maximum zoom value):

1. Tap the Digital Zoom Limit drop down menu. 
2. Select the zoom limit (1x to 12x).

To adjust the Zoom setting, do one of the following:

• Tap and drag the Zoom slider handle upwards to zoom in (telephoto), or downwards to zoom out 
(wide). The farther the Zoom slider handle is from center, the faster the lens zooms.

• Tap and hold the Tele button or the Wide button.
Tip: To adjust the zoom rate, go to the Config > Operation > Joystick area, and then adjust Zoom 
Tele/Wide Button Sensitivity.

Iris Controls

Figure 10 - Iris Controls

To turn on Auto Iris:

• Tap Auto Iris > On.

Note: The Iris controls for the Sony ILME-FR7 are velocity based (just as the Zoom and Focus controls 
are).

To adjust the iris manually:

• Tap Auto Iris > Off, and then do one of the following:
› On the Iris slider, tap either Open or Close. The iris moves one step with each tap.
› Tap and drag the Iris slider handle upwards to open the iris, or downwards to close it.
Tip: To adjust the Iris Open/Close Sensitivity on Sony ILME-FR7, BRC-AM7, and Panasonic PTZ 
cameras, go to the Config > Operation > Joystick area, and then adjust Iris Open/Close Button 
Sensitivity.
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Focus Controls

Figure 11 - Focus controls

To turn on Auto Focus:

• Tap Auto Focus > On.

To automatically focus the lens once:

• Tap Auto Focus > Off, and then tap the One Push Auto Focus button.

To adjust focus manually:

• Tap Auto Focus > Off, and then do one of the following:
› Tap and drag the Focus slider handle upwards (Near), or downwards (Far). The farther the Focus 

slider handle is from center, the faster the lens focuses.
› Tap and hold the Near button or the Far button.

Tip: To adjust the focus rate, go the Config > Operation > Joystick area, and then adjust Focus 
Near/Far Button Sensitivity.
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Presets Page
The Presets page consists of banks of preset buttons, each of which can store a preset for future recall.

A preset is a record of all controllable axis positions and selected settings for a camera, including pan, tilt, 
focus, zoom, iris, exposure, white balance, etc.

To access the panel, tap the Presets button.

This section of the User Manual includes the following topics:
• “Interface Overview”
• “About Preset Modes”
• “Presets Page (in Panel Mode)”
• “Presets Page (in Shotbox Mode)”

Interface Overview

Navigation between pages, camera refresh, and tally indication are all available along the top of the 
Dashboard UI, as shown in Figure 12.

Figure 12 - Buttons at the top of the DashBoard UI

• Refresh Camera — Retrieves updated status information from the camera.
• Presets Page — Opens the Presets page, which can be set to either Panel Mode or Shotbox Mode, 

depending on the configuration settings.
• PTZ Page — Opens the PTZ page to allow pan, tilt, and zoom control.
• Paint Page — Opens the Paint page to allow customized Paint setting configuration.
• Config Page — Opens the Configuration page, which allows modification of the Camera, Operation, 

and Gateway settings. 
• ON/OFF-AIR — Displays the tally indicator, which responds in accordance with the tally state.
• Status — Indicates the connection status.

About Preset Modes

The PTZ Camera Control interface has two operation modes, also known as Preset Modes, which define 
the behavior of the Presets page:
• Panel mode — In this mode, you tap a preset to select it, and then tap an action button (Recall, Store, 

Edit Preset Options, or Delete) at the bottom of the Presets page. When you select a preset, the 
border of the preset button turns purple.

• Shotbox mode — In this mode, you tap an action button at the bottom of the Presets page to enter 
an action mode (Recall, Store, Edit Preset Options, or Delete), and then tap the preset to which you 
want to apply the action.
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Tip: If one of the action buttons is colored (purple, yellow, green, or red), the interface is in Shotbox 
mode.

For information about switching between operation modes, see “Preset Mode”.

Presets Page (in Panel Mode)

This section describes features of the Presets page. Information presented here applies only when the 
PTZ Camera Control interface is in Panel mode (as opposed to Shotbox mode). For more information 
about the Presets page as it appears in Shotbox mode, refer to “Presets Page (in Shotbox Mode)”. 

Figure 13 shows the Presets page in Panel mode. The yellow circles identify buttons and areas of the 
user interface that are described in the sections that follow. If you are reading this document on a 
computer, tap the numbered buttons or areas of the diagram to jump to the descriptions.

Figure 13 - Presets page (in Panel mode)

Manage Banks Button
Opens the Manage Banks page, which enables you to configure banks, import and export saved presets, 
and edit names and Recall Options for presets.

For more information, see “Managing Banks and Files”.

Tap HERE to return to the Presets page diagram.

Bank Tabs
Tap a bank tab to switch to that bank of presets. The bank tab turns purple.

Tap HERE to return to the Presets page diagram.

Preset Buttons
The Presets page displays banks of preset buttons: 
• Blue preset buttons represent presets than can be run.
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• Gray preset buttons are either empty, or contain data about deleted presets which can be edited, 
restored, or discarded.

• Shaded preset buttons indicate that presets will be stored and/or recalled from the camera. 
Depending on the Operation configuration, the following will result:
› If Store Presets on Camera is enabled, storing data to one of these presets will also push data to 

the camera.
› If Blind Recall is enabled, you can attempt to recall these presets from the camera, even though no 

data is stored locally.

To work with presets, tap a preset button to select a preset, and then tap an action button. When you 
select a preset, the border of its button turns purple.

For more information, see “Working with Presets in Panel Mode”.

Tap HERE to return to the Presets page diagram.

Recall Button
Recalls the selected preset.

Before you recall the preset, you can set Recall Options. For more information about recalling a preset 
in Panel mode, see “Recall a Preset from Camera”.

Tap HERE to return to the Presets page diagram.

Note: The Recall button displays “Recall From Camera” when a preset will be recalled from camera 
storage. If no data is stored in the matching slot on the camera, recall will fail silently.

Note: When presets are recalled from, or stored on, the camera, slots that are mapped to the camera 
but have no data stored locally appear faded blue. If Blind Recall is enabled when these slots are 
selected, the Recall button displays Recall from Camera and will attempt to recall the preset on the 
camera. When no preset is stored on the matching slot on the camera, recall will fail silently.

Store Button
Stores the current camera position as a preset on the selected preset button.

Depending on the current Store mode, you may be able to review and modify the Preset Options that 
are stored as part of the preset.

For more information about storing presets in Panel mode, see “Store a Preset”.

Tap HERE to return to the Presets page diagram.

Note: When storing to a preset causes data to be stored in the matching preset slot on the camera and in 
local DashBoard storage, the Store button label changes to Store on Camera.

Edit Preset Options Button
Opens the Edit Options dialog box, which enables you to specify Preset Options for the selected preset.

For more information, see “Edit Preset Options”.

Tap HERE to return to the Presets page diagram.

Delete Button
Deletes the local copy of the selected preset.
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A deleted preset cannot be recalled, but its data persists. The deleted preset can later be edited, 
restored, or discarded. For more information, see “Manage Deleted Presets (Restore or Discard)”.

Note: The Delete button deletes the local copy of the preset, but does not delete presets stored on the 
camera. This note is relevant only if your system is configured to store presets locally and on the camera 
(Manage Presets on Camera setting is Enabled).

Tap HERE to return to the Presets page diagram.

Store Options > Edit Defaults Button
Opens a dialog box where you can specify default Preset Options. When an operator stores a preset, the 
default Preset Options are either presented for review and approval or automatically applied, 
depending on the current Store mode.

For more information, see “Edit Default Preset Options”.

Tap HERE to return to the Presets page diagram.

Recall Options Area
Recall Options determine whether Preset Options specified in the preset are to be applied during 
recall.

The Recall Options settings enable you to Allow or Ignore the Preset Options for Focus, Exposure, 
and White Balance.

If Allow and Ignore buttons are not available for an option, it is because the mode/setting listed directly 
below it overrides that option.

For more information about recalling presets, see “Recall a Preset from Camera”.

Tap HERE to return to the Presets page diagram.

Delete Options > Manage Deleted Presets Button
Opens the Manage Deleted Presets page, which enables you to restore or discard deleted presets.

For more information, see “Manage Deleted Presets (Restore or Discard)”

Tap HERE to return to the Presets page diagram.

Presets Page (in Shotbox Mode)

This section describes Preset panel features and how to use them. It applies only when the PTZ Camera 
Control interface is in Shotbox mode (as opposed to Panel mode). For more information about the 
Presets page as it appears in Panel mode, refer to “Presets Page (in Panel Mode)”. 

Figure 14 shows the Presets page in Shotbox mode. The red circles identify buttons and areas of the user 
interface that are described in the sections that follow. If you are reading this document on a computer, 
tap the numbered buttons or areas of the diagram to jump to the descriptions.
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Figure 14 - Presets page (in Shotbox mode, with Recall mode enabled)

Manage Banks Button
Opens the Manage Banks page, which enables you to configure banks, import and export saved presets, 
and edit names and Recall Options for presets.

For more information, see “Managing Banks and Files”.

Tap HERE to return to the Presets page diagram.

Bank Tabs
Tap a bank tab to switch to that bank of presets. The bank tab turns purple.

Tap HERE to return to the Presets page diagram.

Preset Buttons
The Presets page displays banks of preset buttons:

Colored buttons represent presets that have not been deleted. The color of all such buttons is the same 
at any given time, and represents the current action mode:
• Purple — Recall mode. Tap a preset button to recall its preset.

 

• Yellow — Store mode. Tap a preset button to store a preset on it.
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• Green — Edit Preset Options mode. Tap a button to edit Preset Options for the preset. 

• Red — Delete mode. Tap a preset button to delete its preset.

 

• Gray — empty, or contain Preset Options data about deleted presets, which can be restored or 
discarded.

• Shaded — preset locations that will be recalled from camera and pushed to camera when saved.

To work with presets, tap an action button at the bottom of the Presets page to enter an action mode 
(Recall, Store, Edit Preset Options, or Delete), and then tap the preset to which you want to apply the 
action.

For more information, see “Working with Presets in Shotbox Mode”.

Tap HERE to return to the Presets page diagram.

Recall Button (Recall Mode)
The Recall button places the Presets page into Recall mode. Preset buttons containing presets that can 
be recalled turn purple. Tap a purple preset button to recall its preset.

Faded purple slots indicate mapped slots have no locally stored data, but can be recalled from camera 
storage when Blind Shot Recall is enabled. If no data is stored on the camera, the recall will fail silently. 

When the Presets page is in Recall mode, the Recall Options area is available (Figure 15).
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Figure 15 - The Recall Options area

Recall Options determine whether Preset Options specified in the preset are to be applied during 
recall.

The Recall Options settings enable you to Allow or Ignore the Preset Options for Focus, Exposure, 
and White Balance.

If Allow and Ignore buttons are not available for an option, it is because the mode/setting listed directly 
below it overrides that option.

Note: Recall options only apply when presets are stored locally on the DashBoard computer. For Canon 
PTZ cameras where local storage is not supported, recall options are not shown.
For more information about recalling presets, see “Recall a Preset”.

Tap HERE to return to the Presets page diagram.
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Store Button (Store Mode)
Places the Presets page into Store mode. Preset buttons containing presets that can be recalled turn 
yellow. Tap any preset button to store the current camera position as a preset.4

Faded yellow mapped slots indicate locations mapped to camera storage but have no data stored locally 
when Store Presets on Camera is enabled. Storing to a shaded slot causes data to be stored to both 
local and camera storage on the matching slot. 

Store Options Area

When the Presets page is in Store mode, the Store Options area is available (Figure 16).

Figure 16 - Store Options area

The Edit Defaults button opens the Edit Default Preset Options dialog box (Figure 17).

Figure 17 - Edit Default Preset Options dialog box

In this dialog box, you can define the default Preset Options, which are presented and/or applied each 
time you create a preset.

Note: Preset recall options only apply when presets are stored locally on the DashBoard computer. For 
Canon PTZ cameras where local storage is not supported, preset recall options are not shown.
For more information, see “Edit Default Preset Options”.
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Camera Control Area

When the Presets page is in Store mode, the Camera Control area is available (Figure 18).

Figure 18 - Camera Control area

The Camera Control area includes the following controls:
• Pan/Tilt — Tap and drag the cross-hairs away from center. The farther the cross-hairs are from 

center, the faster the camera moves.
• Zoom — Tap and drag the Zoom slider handle to the right to zoom in (telephoto), or to the left to 

zoom out (wide). The farther the Zoom slider handle is from center, the faster the lens zooms.
• Focus — Tap and drag the Focus slider handle to the right (near), or to the left (far). The farther 

the Focus slider handle is from center, the faster the lens focuses.

Note: The Focus slider handle is available only if Auto Focus is Off. For more information, 
see “PTZ, Iris, and Focus Controls”.

• Iris — Tap and drag the Iris slider handle to the right to open the iris, or to the left to close it.

Note: The Iris slider handle is available only if Auto Iris is Off. For more information, see 
“PTZ, Iris, and Focus Controls”.
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• One Push Auto Focus — Tap this button to perform a one-time auto focus.

Note: The One Push Auto Focus button is available only if Auto Focus is Off. For more 
information, see “PTZ, Iris, and Focus Controls”.

• One Push White Balance — Tap this button to perform a one-time white balance. Applies to Ross 
Video PTZ cameras and Sony BRC cameras.

Note: The One Push White Balance button is available only if the White Balance Mode is 
set to One Push. For more information, see “Paint Controls”.

• Trigger AWB — Tap this button to perform a one-time white balance. Applies to Panasonic 
cameras.

Note: The Trigger AWB button is available only if the White Balance Mode is set to AWB A 
or AWB A. For more information, see “Paint Controls”.

Tap HERE to return to the Presets page diagram.

For more information about storing presets in Shotbox mode, see “Store a Preset”.

Edit Preset Options Button (Edit Preset Options Mode)
Places the Presets page into Edit Preset Options mode. Preset buttons containing presets that can be 
recalled turn green. Tap any preset button to update the name and preset options for that preset.

For more information, see “Edit Preset Options”.

Tap HERE to return to the Presets page diagram.

Delete Button (Delete Mode)
Places the Presets page into Delete mode. Preset buttons containing presets that can be deleted turn 
red.

Tap any red preset button to delete its preset. The preset button turns gray. A deleted preset cannot be 
recalled, but its data persists. It can later be edited, restored, or discarded.

To manage deleted presets, in the Delete Options area, tap the Manage Deleted Presets button. The 
Manage Deleted Presets page appears. For more information, see “Manage Deleted Presets (Restore 
or Discard)”

Tap HERE to return to the Presets page diagram.

Note: When you delete a preset, only the local copy is deleted. If your system is configured to store 
presets locally and on the camera (Manage Presets on Camera setting is Enabled), the camera still 
retains the preset in its memory.

Options Area
The Options area contains options that are specific to the current action mode:
• Recall mode — Recall Options. For more information, see “Recall Button (Recall Mode)”.
• Store mode — Store Options and Camera Controls. For more information, see “Store Button (Store 

Mode)”.
• Edit Preset Options mode — No options are presented for this mode.
• Delete mode — Delete Options. For more information, see “Delete Button (Delete Mode)”.

Tap HERE to return to the Presets page diagram.
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Paint Controls
This section contains topics about controls that are available on the Paint page:
• “Exposure Controls”
• “Color Controls”
• “Open On-Screen Menu Button”

Note: Some features described in this section are not available on all cameras. The selection of features 
and the appearance of the interface may vary between camera models. Unless stated otherwise, figures 
and feature descriptions in this section describe the interface as it appears for Ross Video PTZ Cameras. 
For information about paint controls for other camera brands, refer to the user manuals for those 
cameras.

To access the Paint page, tap the Paint button.

Exposure Controls

Figure 19 - Exposure controls for PTZ Cameras

Mode Buttons
• Full Auto — The exposure settings are automatic. Manual adjustment is not available.
• Manual — You can manually adjust Iris, Shutter, and Gain settings. To adjust exposure settings, 

either tap and drag the appropriate slider handle, or tap the buttons at the ends of the slider.
• Shutter Priority — You can manually adjust the Shutter. The Iris and Gain settings are automatic.
• Iris Priority — You can manually adjust the Iris. The Shutter and Gain settings are automatic.
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Backlight Button

When the backlight setting is On, automatic exposure settings assume the subject is backlit, and adjust 
accordingly. Backlight mode is available only when Full Auto Exposure is enabled.

Note: For the Sony ILME-FR7 and BRC-AM7 camera, settings such as Iris, Shutter, and Gain through Visca 
are either unavailable or limited. The following controls are:

› Iris — Auto On/Off and Open/Close increments
› Shutter — Auto On/Off only
› Gain — Auto On/Off only

Note: The extended ND Filter controls are also available.

Color Controls

Figure 20 - Color Controls

Tap a button to select a White Balance Mode:
• In Manual mode, you can adjust Red Gain and Blue Gain manually.
• For most modes, the Red Gain and Blue Gain sliders adjust to predetermined positions automatically.
• One Push mode makes the One Push White Balance button available.
• On Panasonic cameras, AWB  A mode or AWB B mode makes the Trigger AWB button available.

Open On-Screen Menu Button
The Open On-Screen Menu button (Figure 21 -) opens the Menu Control page, which enables you to 
adjust camera settings using the on-screen menu. For more information, see “On-Screen Menu”.

Figure 21 - - The Open On-Screen Menu button
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Configuration Settings and 
On-Screen Menu
This section contains topics about controls that are available on the Config page. To open the main 
Configuration Settings page, tap the Config button.

Depending on the model of camera, the main Configuration Settings page includes some or all of the 
buttons shown in Figure 22. Some camera models have an Video Mode button instead of an 
Audio/Video button.

Figure 22 - Buttons at the top of the Configuration Settings page

• Camera — Opens the Camera Settings page, which includes Camera Info settings and Camera 
Options settings. For more information, see “Camera Settings Page”.

• Audio/Video — Opens the Audio/Video Settings page, which includes SDI Video settings and Audio 
settings. For more information, see “Audio/Video Settings Page”.

• Video Mode — Opens the Video Mode page, which enables you to set video modes for SDI Video, 
Mainstream Video, and Substream Video. For more information, see “Video Mode Settings Page”.

• Operation — Opens the Operation Settings page, which includes Joystick settings and Interface 
settings. For more information, see “Operation Settings Page”.

• Gateway — Opens the Gateway Settings page, which includes tally interface settings, as well as 
settings for establishing VISCA and/or Furio communication gateways that enable external systems to 
control the camera. For more information, see “Gateway Settings Page”.

• Open On-Screen Menu — Opens the Menu Control page, which enables you to adjust camera 
settings using the on-screen menu. For more information, see “On-Screen Menu”.

• Pan/Tilt Reset — Returns the camera to a known home position.

Note: Some features described in this section are not available on all cameras. The selection of features 
and the appearance of the interface may vary between camera models. Unless stated otherwise, figures 
and feature descriptions in this section describe the interface as it appears for Ross Video PTZ-12G 
cameras. For information about configuration controls for other camera types, refer to the user manuals 
for those cameras.
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Camera Settings Page

The Camera Settings page includes the Camera Info area and the Camera Options area (Figure 23).

Figure 23 - Camera Settings page for a PTZ-12G+ camera (PTZ-NDI has same settings)

Note: Configuration settings vary between camera models. Some settings shown and described in this 
section may not apply to your camera.

Camera Info Area
The Camera Info area displays camera information, as provided by the camera (Figure 24).

This section describes camera information provided by Ross Video PTZ-12G cameras. Information 
provided by other types of PTZ cameras may vary.

Figure 24 - Camera Info area for a PTZ-12G+, PTZ-12G, or PTZ-NDI camera

Name

The name of the camera, as it appears in the DashBoard tree and in the PTZ Camera Control Plugin. The 
camera name is defined when you add the camera to DashBoard.

Role

A unique identifier for the camera, as a reference to enable the capture and storage of thumbnail images 
in camera control systems such as SmartShell, via the Furio gateway.
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The Role value can be edited. By default, the Role value is PTZx, where x is the camera’s slot number in 
the DashBoard tree. Other device types, such as Ross Video pan & tilt heads, have different default 
prefixes instead of PTZ. It is important to ensure that all Role values are unique, and conform to the 
requirements of the system(s) using them.

Valid characters are limited to alpha-numeric characters and the underscore ( _ ) symbol. Other 
characters are automatically removed.

Notes: If you set a Role value that is already in use for another camera, the new Role value is ignored, 
and the previous camera retains its role value.

Type

The type of camera, such as Ross Video PTZ-12G+, PTZ-12G or PTZ-NDI, PIVOTCam-SE, Sony BRC-H900, 
Sony BRC-X1000, Sony ILME-FR7, Sony BRC-AM7, Panasonic AW-UE150, AW-UE160, AW-HR140, 
Lumens VC-A71P, Lumens VC-A71PN, Canon CR-N300, Canon CR-N500, or CR-X300.

Status

The operational status of the camera.

Model

Additional model number, as reported by the camera.

IP

The IP address of the camera.

FW

The version(s) of firmware currently installed on the camera.

Port

The port number used to communicate with the camera.

Camera Options Area
The Camera Options area (Figure 25) includes camera settings, some of which may be specific to the 
model of camera you are configuring. Some settings described in this section of the manual are not 
available on all camera models.

For detailed information about camera settings, consult your camera manual.



User Manual for PTZ Camera Control Plugin Configuration Settings and On-Screen Menu  •  35

Figure 25 - Camera Options area for a PTZ-12G+, PTZ-12G, or PTZ-NDI camera

Power

Tap On to turn the camera on. Tap Standby to put the camera in standby (non-operational) mode.

IR

Controls whether the camera can receive commands from the IR (infra-red) remote control unit.

Tap On to turn on the IR receiver. Tap Off to turn off the IR receiver.

Image Flip and Image Mirror

Image Flip reverses the video image vertically.

Image Mirror reverses the image horizontally.

Tips:
• Configure the Image Flip and Image Mirror settings before you create any presets. Changing camera 

orientation makes existing presets useless.
• For cameras mounted upside-down on the ceiling, set Image Flip and Image Mirror to On.
• If you change the Image Flip and Image Mirror settings remember to configure the Horizontal Axis 

and/or Vertical Axis joystick settings (Config > Operation > Joystick) so the direction of joystick 
motion corresponds with the direction of camera movement.

Ceiling Mount

For some cameras, such as Sony cameras and PIVOTCam-SE cameras, a Ceiling Mount setting (Figure 26) 
is shown instead of Image Flip and Image Mirror. When On, Ceiling Mount rotates the camera image 
180 degrees.
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Figure 26 - Ceiling Mount setting

Note: If you change the Ceiling Mount setting for a Sony camera, you must power cycle the camera 
afterwards to apply the change. All presets are erased.

Tips:
• Configure the Ceiling Mount setting before you create any presets. Changing camera orientation 

makes existing presets useless.
• For cameras mounted upside-down on the ceiling, set Ceiling Mount to On.
• If you change the Ceiling Mount setting, remember to configure the Horizontal Axis and Vertical 

Axis joystick settings (Config > Operation > Joystick) so the direction of joystick motion corresponds 
with the direction of camera movement.

2D Noise Reduction

2D noise reduction creates clearer images in low light conditions through temporal noise reduction, 
which is based on analysis of differences between video frames.

You can turn this feature Off or select one of three levels from Level 1 (weak) to Level 3 (Strong).

3D Noise Reduction

3D noise reduction creates clearer images in low light conditions through both temporal and spatial 
noise reduction:
• Temporal noise reduction is based on analysis of differences between video frames.
• Spatial noise reduction reduces noise within each video frame without comparison to other frames.

You can turn this feature Off or select one of three levels from Level 1 (weak) to Level 3 (Strong).

Flicker Compensation

Compensates for light flicker caused by disparity between the video frame rate and the frequency of the 
AC power supply for lighting.

Smart Auto Focus

Enables face detection and auto focus. When On, Auto Focus focuses mainly on the face.

This setting is available only when the Auto Focus option on the PTZ page is On. For more information, 
see “Focus Controls”.

Note: When you change this setting, the video feed is briefly interrupted. Tap OK if you wish to proceed.

Variable Zoom

Varies the speed of the pan and tilt axes when you control them manually, based on the zoom position. 
When the lens is zoomed in, the affected axis moves more slowly. When the lens is zoomed out, the 
affected axis moves more quickly.
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Wiper Connection (CR-X300 only)

The Canon-X300 plugin can be configured to expose controls to activate the wiper mechanism on the 
camera. To do this, a separate HTTP connection must be established with the camera. When a wiper 
control connection is successfully established, wiper buttons will be enabled on the Presets and PTZ 
pages of the plugin.

Note: Configuring the HTTP connection is not necessary if wiper control is not required.

Depending on your setup, you may need to configure HTTP authentication with a username and 
password. This can only be done when the wiper connection is disabled.

To configure the wiper connection

1. Navigate to the Wiper Control Connection section in the Camera Options area. Refer to Figure 27.

Figure 27 - Wiper Control Connection section

2. Set the Port number to the configured port on the camera.
3. Select Configure Authentication (if required). Refer to Figure 28.

Figure 28 - HTTP Authentication Configuration dialog box
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Note: The HTTP connection depends on the camera settings and how User Management is set up 
for the CR-X300:
• If the Guest User has Camera Control privileges, no authentication is required in DashBoard. 

Leave the Username and Password fields empty.
•  If the Guest User does not have Camera Control privileges, authentication is required in 

DashBoard. Enter a Username and Password with Camera Control privileges that match a user 
account previously set on the camera.
Tip: To configure the camera for secure connection, go to System > Server > HTTP Video in the 
camera Web UI and set Authentication Method to Digest Authentication.

4. Select Done to return to Wiper Control Connection.
5. Select Enable in the Control setting.

Note: The camera’s Port connection and IP address display automatically if the camera connection is 
established on DashBoard already.

To confirm everything works correctly, select either the Wiper or Washer buttons to activate the 
camera’s wiper and washer functions.
Note: Presets cannot be recalled while the washer is in operation. 
Wiper controls are disabled when the camera is on-air.

Connection status

The connection status indicates whether the wiper link is properly configured and the connection is 
successfully established. 

Connection statuses include the following:
• Disabled — Wiper control is disabled.
• Error — Wiper control is enabled, but not properly configured. Wiper controls are inaccessible and 

device status displays a warning of “No wiper control.” Refer to Figure 29.

Figure 29 - No wiper control message

Status messages provide information on the error, including:
› Failed authentication — Verify that the provided username and password align with a valid set of 

credentials within the camera control permissions on the connected camera.
› Offline - no communication — Confirm that the port matches the port set on the camera.

• OK — Wiper control is enabled and correctly configured. Wiper controls are accessible in DashBoard.

To set up wiper and washer joystick control

To control the wiper and washer, refer to instructions on setting up a joystick are available in “Adding 
USB Joysticks or Other USB Controllers”, and Table 2 on page 77.
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Camera Polling
The Camera Polling Period setting allows you to define an interval to poll the camera to pick up changes 
made by controllers other than DashBoard. Polling is disabled by default. Refer to Figure 30.

Figure 30 - The Camera Polling Period settings

Note: This feature generates a lot of message traffic if enabled. Many PTZ cameras polling on the same 
network may cause slowdowns. 

Configuring Authentication (Panasonic Cameras Only)
To enable communication with a Panasonic PTZ camera that has authentication enabled, configure the 
required username and password in DashBoard.

To configure authentication:

1. In the PTZ Camera Control plugin, navigate to Config > Camera > Configure Authentication.
2. In the HTTP Authentication Configuration dialog box, enter the required Username and 

Password, then tap Done.

Figure 31 - HTTP Authentication Configuration dialog box

Note: For authentication to function correctly:
• The camera must be set to use Digest authentication.
• The user account must have at least Camera Control privileges.
• If available on your camera model, set Wait Time Mode to Mode 2.

Tip: It is recommended to enter the credentials in DashBoard before enabling authentication on the 
camera. Enabling authentication first may prevent DashBoard from connecting, as the camera may 
reject all HTTP connection attempts.

Refer to the Panasonic camera’s operator manual for model-specific setup instructions
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Audio/Video Settings Page

The Audio/Video Settings page includes the SDI Video area and the Audio area (Figure 32).

Figure 32 - Audio Video settings page for a PTZ-12G camera

SDI Video Area
The SDI Video area (Figure 33) enables you to set the resolution and frequency for SDI video output.

Figure 33 - SDI Video area

Select a Resolution and a Frequency, and then tap the Apply Changes button.

Note: Some combinations of resolution and frequency are non-standard and not supported. The Apply 
Changes button is available only if the selected video format is supported.
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Audio Area
The Audio area (Figure 34) enables you to specify audio input properties.

Figure 34 - Audio area

Enable Audio

Enables or disables audio input.

Note: When you Enable or Disable audio input, the video feed is briefly interrupted. Tap OK if you wish 
to proceed.

Audio Volume

Sets the audio volume from 0 (lowest) to 10 (highest).

This setting is available only when audio is enabled.

Audio in Type

Selects the type of audio input (Mic in or Line in).

This setting is available only when audio is enabled.

Enable Audio Delay

When enabled, audio is delayed. Use this feature to synchronize audio and video.

To set the delay period, adjust the Audio Delay Time slider or specify a delay value (1 to 500 
milliseconds) in the Audio Delay Time box. 

This setting is not supported on PTZ-12G+ and PTZ-NDI cameras when NDI|HX video is enabled in the 
web interface.
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Audio Encoding/Sample Rate

Sets the encoding type and sample rate for encoding incoming audio. For SDI video on PTZ-12G cameras, 
only 48 kHz (AAC) is supported. This setting is not supported on PTZ-12G+ and PTZ-NDI cameras when 
NDI|HX video is enabled in the web interface.

This setting is available only when audio is enabled.

Video Mode Settings Page

For the PIVOT-SE, the Video Mode page is shown instead of the Audio/Video page. 
This allows you to configure the main SDI video and also the mainstream and substream video options 
for the camera.
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Operation Settings Page

The Operation Settings page (Figure 35) includes the Joystick area and the Interface area.

Figure 35 - Operation Settings page for a Sony RBC-X1000 camera

Joystick Area
The Joystick area (Figure 36) includes settings related to joystick behavior, and to the sensitivity of Zoom 
and Focus buttons on the PTZ page.

Figure 36 - Joystick area for a Panasonic PTZ camera



44  •  Configuration Settings and On-Screen Menu  User Manual for PTZ Camera Control Plugin

Horizontal Axis and Vertical Axis

You can co-ordinate the direction of joystick motion with the direction of camera motion:
• Horizontal Axis — Determines which direction (right/left) you need to push the joystick to pan the 

camera right or left.
• Vertical Axis — Determines which direction (forward/back) you need to push the joystick to tilt the 

camera up or down.

Use the joystick to move the camera, observe the camera motion, and then adjust these settings as 
desired.

Note: For PIVOTCam-SE cameras, Sony BRC cameras, and Lumens  PTZ cameras, these axis direction 
settings affect pan and tilt controls in DashBoard and in any external controllers.

Note: For Ross Video PTZ-12G+, PTZ-12G, and PTZ-NDI cameras, Panasonic models, and Sony ILME-FR7 
and BRC-AM7 cameras, these axis direction settings apply within DashBoard only, and do not change any 
settings on the camera or affect control by any external controllers.

Zoom Tele/Wide Button Sensitivity

The Zoom control on the PTZ page includes Tele and Wide buttons that enable you to manually zoom 
the camera lens. Use the Zoom Tele/Wide Button Sensitivity slider to set how quickly the camera 
zooms.

Focus Near/Far Button Sensitivity

The Focus control on the PTZ page includes Near and Far buttons that enable you to manually focus the 
camera lens. Use the Focus Near/Far Button Sensitivity slider to set how quickly the camera focuses.

Iris Open/Close Button Sensitivity (Panasonic, Sony ILME-FR7, and Sony AM7 cameras only)

The Iris control on the PTZ page includes Open and Close buttons that enable you to manually adjust 
the aperture. Use the Iris Open/Close Button Sensitivity slider to set how quickly the iris opens and 
closes.

Note: This sensitivity slider affects the behavior of iris controls within DashBoard, but does not change 
any settings on the camera.

Interface Area
The Interface area (Figure 37 -) includes settings related to the behavior of the user interface.
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Figure 37 - Interface area

The Blind Shot Recall setting specifies whether you can attempt to recall a shot from the camera when 
there is no locally stored data in the slot:
• Disable — Empty camera slots cannot be recalled.
• Enable — Empty camera slots can be recalled.

Preset Mode

Tap one of the following Preset Mode buttons to define the behavior of the Presets page:
• Panel — In this mode, you tap a preset to select it, and then tap an action button (Recall, Store, Edit 

Preset Options, or Delete). When you select a preset, the border of the preset button turns purple.
• Shotbox — In this mode, you tap an action button at the bottom of the Presets page to enter an 

action mode (Recall, Store, Edit Preset Options, or Delete), and then tap the preset to which you 
want to apply the action.

Store Mode

There are two store modes:
• If Store Mode is set to Confirm, the operator can review and modify Preset Options when they store 

a preset.
• If Store Mode is set to Don't confirm, default Preset Options are automatically stored with the 

preset.

To access settings to define the default Preset Options:

• Tap Presets, and then do one of the following:
› If the Store Options area is visible (top right corner), tap the Edit Defaults button. The Edit Default 

Preset Options dialog box appears.
› If the Store Options area is not visible, tap the Store button. The Store Options area appears. Tap 

the Edit Defaults button. The Edit Default Preset Options dialog box appears.
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Preset Number Display Offset

Presets are numbered. You can set the numbering to start at 0 or at 1.

This is an aesthetic choice; changing between ID start at 0 and ID start at 1 does not change how 
presets are stored in DashBoard or on the camera. The setting can be changed at any time.

For many external VISCA controllers, such as Carbonite, preset numbering starts at 1. If such a VISCA 
controller recalls preset 1, the first preset is recalled, regardless of whether the PTZ Camera Control 
plugin shows it as preset 0 or 1. To avoid confusion, when using an external VISCA controller we 
recommend you set Preset Number Display Offset to match the controller’s numbering. By default, 
preset numbering on PTZ-12G+, PTZ-12G, and PTZ-NDI cameras starts at 0.

Preset Validation

Preset Validation ensures that all expected shot data is present before saving a preset and is enabled by 
default. However, some third-party PTZ cameras that are not directly supported by the plugins do not 
provide all the expected preset data, therefore validation can be disabled to support storing these 
presets.

The options are as follows:
• Enable: Ensures complete data availability before storing a preset, ideal for full compatibility.
• Disable: DashBoard attempts to store available data, placing the responsibility on the user to verify 

preset success. This mode accommodates use with certain unsupported cameras.

Note: This feature is specifically available for Panasonic and Sony camera plugins. For all other camera 
plugins, preset validation remains perpetually active, ensuring reliability across diverse hardware setups.

Store Presets on Camera

You can specify whether presets stored by the PTZ Camera Control plugin are stored in local memory 
AND in the camera’s memory, or only in local memory:
• Disable — Presets are stored in local memory only.
• Enable — Presets are stored in local memory and on the camera.

Note: Each camera can store a limited number of presets. Any presets numbered higher than the 
storage capacity of the camera are stored in local memory only. 

For Canon PTZ cameras, this setting is read-only, as presets will always be stored in the Camera.
Tip: PTZ-12G+, PTZ-12G, and PTZ-NDI cameras can store up to 256 presets (0 - 255).

Recall Presets From

You can specify whether presets are recalled from the camera or from local memory:
• Local — Presets are recalled from local memory only, not from the camera.
• Camera — Presets are recalled from camera memory. Presets numbered higher than the storage 

capacity of the camera are recalled from local memory. For example, if the camera capacity is 256 
presets starting at 0, then presets 0 to 255 are recalled from camera memory, and presets 256 
onwards are recalled from local memory.

WARNING: If no data is stored for a slot on the camera, the shot recall will fail silently.

Tip: If there is no preset stored in a given preset memory on the camera, and that preset is recalled, 
nothing happens. The camera position does not change, and there is no error message to tell you the 
preset is empty.

Note: For Canon PTZ cameras, this setting is read-only, as presets will always be stored in the Camera.
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Number of Presets on Camera

You can limit the number of camera-memory presets the PTZ Camera Control plugin interacts with.

If Manage Presets on Camera is set to Enable, we recommend setting the Number of Presets on 
Camera to a quantity that fills a number of banks precisely.

IMPORTANT: Do not set this value to a number greater than the number of preset slots available on 
your camera.

For example, if camera can store up to 128 presets, and you want each bank to contain 40 shots, then we 
recommend that you set Number of Presets on Camera to 120. This results in the first three banks (3 x 
40 = 120) consisting entirely of presets stored on camera. Any presets numbered higher than the 
Number of Presets on Camera are stored in local memory only.

Note: This setting is read-only for Canon PTZ cameras.

Tip: PTZ-12G and PTZ-NDI cameras can store up to 256 presets.

Blind Shot Recall

The Blind Shot Recall setting specifies whether you can attempt to recall a shot from the camera when 
there is no locally stored data in the slot:

•    Disable — Empty camera slots cannot be recalled.

•    Enable — Empty camera slots can be recalled.

WARNING: If no data is stored for a slot on the camera for Blind Shot Recall, recall will fail silently.

Log Level

You can set the level of detail recorded in system activity logs. More intensive logging consumes CPU 
capacity and results in more logging data.

The default setting is Normal. There is no need to adjust the logging level unless requested to do so by 
Ross Video.

Gateway Settings Page

The Gateway Settings page (Figure 38) has settings for establishing VISCA and/or Furio communication 
gateways, to enable external systems to control the camera. It also includes tally interface settings.
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Figure 38 - Gateway Settings page

VISCA Gateway
VISCA Gateway settings (Figure 39) enable you to open a server port to connect VISCA controllers, such as 
a Carbonite switcher, to the camera via the camera control panel.

The communication protocol is serial VISCA over TCP. Only a subset of VISCA commands is supported. 
This VISCA gateway implementation is not compatible with the legacy PIVOTCam Control Panel.

Tip: In the PTZ Camera Control plugin, you can configure whether the numbering of presets starts at 0 or 
1. The setting is purely aesthetic, and can be changed at any time. For many external VISCA controllers, 
such as Carbonite, preset numbering starts at 1. If such a VISCA controller recalls preset 1, the first preset 
is recalled, regardless of whether the PTZ Camera Control plugin shows it as preset 0 or 1. To avoid 
confusion, when using an external VISCA controller we recommend you set Preset Number Display 
Offset to match the controller’s numbering. For more information, see “Preset Number Display 
Offset”, which is within the section, “Operation Settings Page”.

Figure 39 - VISCA Gateway settings

VISCA Gateway settings include the following:

• Control — To open a server port, set Control to Enable.
• Port — The port number. Can be edited only when Control is set to Disable.
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• Status (read-only):
› Closed — The port is closed, either because the gateway is disabled or because DashBoard is not 

connected to the target camera.
› Ready — The port is open, but no controllers are currently connected to it.
› Connected — The port is open and one or more controllers are connected to it.
› Error — Typically means that the selected port is unavailable. For example, it may be in use by a 

different service or as a gateway for a different camera.
• Connections (read-only) — When status is Connected, shows how many connections are established.
• Focus Mode:

› Pass — External controllers are allowed to send focus mode control messages through the gateway.
› Block — Prevents focus mode control messages from being passed through the gateway to the 

camera. External controller can still read the current state of camera auto focus mode from the 
camera control panel. This is done because Carbonite always pushes its desired auto focus mode, 
which means that when Carbonite is connected, no other controller can set auto focus.

Note: If a VISCA controller triggers a preset store in an empty DashBoard slot, the preset is given the 
name "Remote", and default store options are applied. If a preset is stored to a location that already has 
name and preset options set, that name and preset options are retained and the preset is updated with 
the current camera position.
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Furio Gateway
Furio Gateway settings (Figure 40) enable you to open server ports to allow external devices to control the 
camera using Furio API commands. You can control the camera using SmartShell, an Acuity production 
switcher, or another device that sends Furio API commands.

Figure 40 - Furio Gateway settings

Both the DashBoard computer running the PTZ Camera Control Plugin, and the external Furio control 
device must be properly configured to establish control of the camera.

The Command Channel and Status Channel are ports on the DashBoard computer that must be 
opened to enable an external Furio control device to communicate with the PTZ cameras.

The UDP Direct Control Channel consists of a Port and IP Address on the DashBoard computer. The 
Furio Joystick Panel must be able to access the port and IP address.

The Status box for each channel may display any of the following messages:
• Closed — The port is closed, either because the gateway is disabled or because DashBoard is not 

connected to the target camera.
• Ready — The port is open, but no controllers are currently connected to it.
• Connected — The port is open and one or more controllers are connected to it.
• Error — Typically means that the selected port is unavailable. For example, it may be in use by a 

different service or as a gateway for a different camera.

When the gateway is enabled, the Connections box in the Command Channel area and in the Status 
Channel area display the number of established connections.

Tip: Port numbers and IP addresses for the Furio Gateway can be configured only while the gateway is 
Disabled.

The Configuration Options to Invert Iris is available for all PTZ cameras. When enabled, iris velocity 
changes requested through Furio Gateway are inverted. To revert to Dashboard v9.15 or earlier version 
behavior, Enable the Invert Iris option.
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Reporting of Movement Away from Preset Position

When controlling a PTZ camera through the Furio Gateway, the gateway reports when the camera has 
moved away from a preset position. In SmartShell this would have the effect of changing the border 
around the last recalled preset from dark blue to light blue. Motion is reported only for pan, tilt, zoom 
and focus axes changed by a controller connected to the DashBoard plugin hosting the gateway, such as 
when one of the following occurs:
• Movement is requested by the PTZ Camera Control plugin, either by using PTZ controls in the plugin 

interface, or by using a USB game controller.
• Movement is requested by a controller connected to the VISCA or Furio Gateway hosted by the 

DashBoard plugin (for example a SmartShell joystick or Carbonite).

Reporting of Variable Zoom Settings

For cameras that feature a Variable Zoom setting, the variable zoom value is reflected through the Furio 
gateway when it reports the zoomVar setting for the Pan and Tilt axes:
• When Variable Zoom is OFF, zoomVar for Pan and Tilt is reported as 0.
• When Variable Zoom is ON, zoomVar for Pan and Tilt is reported as 100.
• When Variable Zoom is not available, or for all other axes (Zoom, Focus, Iris), zoomVar is reported as 

50.

In all cases, zoomVar cannot be changed through the Furio Gateway.

Tally Interface
Settings in the Tally Interface area (Figure 41) enable listeners to receive tally signals, assign a tally ID for 
the camera, and specify control of the tally indicator on the camera.

The top of the PTZ Camera Control interface features a tally indicator (ON-AIR / PREVIEW / OFF-AIR).

Figure 41 - Tally Interface settings

Settings in the Tally Interface work in conjunction with the DashBoard Tally Service. You must enable 
the DashBoard Tally Service and then configure tally settings for your camera.

To enable the DashBoard Tally Service:

1. From the DashBoard Tree, expand DashBoard Services and the double-tap Tally.

Figure 42 - DashBoard Tree, showing DashBoard Services > Tally
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The DashBoard Tally Service interface appears (Figure 43).

Figure 43 - DashBoard Tally Service interface
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2. Tap the Configuration button, and then turn ON the tally listener type used in your facility 
(Figure 44).

Figure 44 - Specifying a Tally Listener

Tip: To observe incoming tally data, tap the Production button.

To configure tally settings for your camera:

1. In the PTZ Camera Control interface, navigate to Config > Gateway.
2. In the Tally Interface area, specify tally settings for the camera:

a. Set Listener to Enable.

Enabling a listener activates the tally indicator (ON-AIR / PREVIEW / OFF-AIR) at the top of the PTZ 
Camera Control interface. Whenever the tally state changes, the tally indicator responds 
accordingly. Notification of each state change is also delivered to SmartShell over the Furio 
Gateway (if configured).

b. In the Tally ID box, type the tally number for the camera.

c. If you want DashBoard to control the camera’s tally light, set Camera to Enable:

› For PTZ-12G+, PTZ-12G, and PTZ-NDI cameras, PIVOTCam cameras, and Lumens  PTZ 
cameras, the tally light is red when the camera is ON-AIR, and green when the camera is in 
PREVIEW.

› For Sony BRC cameras, there is a red tally light on the camera, which is illuminated when the 
camera is ON-AIR.

› For Sony ILME-FRZ cameras, there are green and red tally lights, which are illuminated when 
the camera is ON-AIR.

› For Panasonic and Canon PTZ cameras, there are separate tally lights for ON-AIR (red) and 
PREVIEW (green).

Note: If you enable control of the camera tally light, the ability to directly control the tally light 
through the VISCA gateway or from a DashBoard CustomPanel is disabled.
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On-Screen Menu

The on-screen menu, controlled through the Menu Control page, enables you to adjust camera settings 
without using the remote control unit that came with the camera. For information about which settings 
are available in the on-screen menu, consult the User Manual that came with your camera.

To access the on-screen menu:

• Tap the Open On-Screen Menu button.  

The Menu Control interface appears (Figure 45).

Figure 45 - Menu Control interface

To adjust settings in the on-screen menu:

1. Connect video output from the camera to a video monitor so you can see the menu options.
2. Tap the up/down and left/right arrows to navigate to the desired setting, and then tap OK button to 

select it.

Note: The on-screen menu is not available for Canon PTZ cameras.
Tips:
• If you want to go up one level in the menu hierarchy, tap the Back button.
• After a period of inactivity (15 seconds for PTZ-12G+, PTZ-12G, and PTZ-NDI cameras), the on-screen 

menu closes automatically. You must close and re-open the Menu Control page to continue using the 
on-screen menu.

• While the on-screen menu is active, all other camera activity is paused.
• The Sony ILME-FR7 menu supports press-and-hold on the on-screen menu buttons.
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Working with Presets
A preset is a saved camera position. It can record all controllable axes and some settings, including pan, 
tilt, focus, zoom, iris, white balance, etc.

This section describes how to work with presets, including creating, editing, and recalling them. It 
includes the following major topics:
• “About Preset Modes”
• “Working with Presets in Panel Mode”
• “Working with Presets in Shotbox Mode”
• “About Preset Options and Recall Options”

About Preset Modes

The PTZ Camera Control interface has two operation modes, also known as Preset Modes, which define 
the behavior of the Presets page:
• Panel mode — In this mode, you tap a preset to select it, and then tap an action button (Recall, Store, 

Edit Preset Options, or Delete) at the bottom of the Presets page. When you select a preset, the 
border of the preset button turns purple.

• Shotbox mode — In this mode, you tap an action button at the bottom of the Presets page to enter 
an action mode (Recall, Store, Edit Preset Options, or Delete), and then tap the preset to which you 
want to apply the action.

Tip: If one of the action buttons is colored (purple, yellow, green, or red), the interface is in Shotbox 
mode.

For information about switching between operation modes, see “Preset Mode”.

Working with Presets in Panel Mode

This section describes how to work with presets in Panel mode. Information presented here applies only 
when the PTZ Camera Control interface is in Panel mode (as opposed to Shotbox mode). For 
information about using the Presets page in Shotbox mode, refer to “Working with Presets in Shotbox 
Mode”.

Unless stated otherwise, tasks described in this section are performed from the Presets page.

To access the Presets page, tap the Presets button.

Before you attempt these procedures, we suggest you review the various controls available on the 
Presets page. For a description of these controls, see “Presets Page (in Panel Mode)”.

This section includes information about performing the following tasks in panel mode:
• “Switch Between Banks of Presets”
• “Store a Preset”
• “Recall a Preset from Camera”
• “Edit a Preset to Change Camera Position”
• “Edit Preset Options”
• “Delete a Preset”
• “Edit Default Preset Options”
• “Manage Deleted Presets (Restore or Discard)”
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Switch Between Banks of Presets
The PTZ Camera Control plugin can store multiple banks of preset buttons.

Banks are represented by bank tabs above the preset buttons. The current bank tab is always purple.

To switch to a different bank:

• Tap the bank tab representing the desired bank.
The bank tab turns purple, and the presets in that bank are accessible.

Store a Preset
A preset is a record of all controllable axis positions and selected settings for a camera, including pan, tilt, 
focus, zoom, iris, exposure, white balance, etc.

When a preset is stored, it includes a set of Preset Options. In addition to the name of the preset, these 
options define whether the Focus, Exposure, and White Balance settings that are saved with the preset 
can be applied when the preset is later recalled. The final decision to Allow or Ignore these defaults is 
made when the preset is recalled. For more information about Preset Options, see “About Preset 
Options and Recall Options”.

Depending on the current Store Mode, you may be required to review the Preset Options. For more 
information, see “Store Mode”.

Important: Recall options are only applicable when recalling a preset from local storage. For Canon PTZ 
cameras, which do not support local storage, these options are not relevant.
Note: For all supported VISCA cameras (PTZ-12G+, PTZ-12G, and PTZ-NDI, PIVOTCam-SE, Sony BRC, and 
Lumens PTZ cameras), a preset does not store the on/off status of automatic camera modes, such as 
Auto Focus, Exposure (Full Auto), and White Balance. It stores the actual values for these settings, but 
not the fact that the camera is in an automatic mode only when recalling from local. For example, if you 
save a preset while Auto Focus is ON, the focus value is stored but the fact that Auto Focus was ON is 
not stored. When the preset is recalled, the focus value is applied, unless the camera is in Auto Focus 
mode. Recalling a preset does not override automatic mode settings. For Panasonic cameras, Auto 
Focus mode is not stored, but exposure and white balance modes are stored and recalled with presets.

Note: With the Sony ILME-FR7 camera, a preset does not store any information about Exposure or 
White Balance settings. Only Pan, Tilt, Zoom, and Focus are stored. 

Tip: Before you store presets, specify where they are stored and from where they are recalled. For more 
information, see “Specify Where Presets are Stored, and from Where they are Recalled”.

To store a preset:

1. Adjust the camera position and settings to prepare the shot.
2. Tap the preset button that you want to use to store the shot.
3. Tap the Store button.

Note: In some modes, this may show Store on Camera to indicate that storing will store both locally 
and in mapped slot in camera storage.

4. If the Store Preset dialog box appears, review and/or modify the Preset Options as follows:

a. In the Preset Name box, type a name for the preset. The name appears on the preset button.

b. Specify whether the Focus, Exposure, and White Balance values stored with the preset can be 
applied when the preset is recalled.

Note: The final decision to Allow or Ignore these defaults is made when the preset is recalled.

c. Tap Store.
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Recall a Preset from Camera
When you recall a preset, its stored pan, tilt, and zoom settings are applied to the camera. Other stored 
settings may also be applied.

Important: Recall options are only applicable when recalling a preset from local storage. For Canon PTZ 
cameras, which do not support local storage, these options are not relevant.
To recall a preset:

1. Tap the preset button that represents the preset you want to recall.
Tip or separate section about recalling a preset from an empty slot

2. In the Recall Options area, specify whether to Allow or Ignore the Preset Options for Focus, 
Exposure, and White Balance.
Tip: If Allow and Ignore buttons are not available for an option, it is because the mode/setting listed 
directly below it overrides that option. Recalling a preset does not always override automatic mode 
settings.
For more information about Recall Options, see “About Preset Options and Recall Options”.

3. Tap the Recall button.
Note: In Panel mode, this displays Recall From Camera when a recall is from camera storage.

Edit a Preset to Change Camera Position
To change the camera position or other settings that are recorded as part of the preset, recall the original 
preset, change the camera position and/or settings as required, and then Store on the same preset 
button.

For information about recalling a preset, see “Recall a Preset from Camera”.

For information about storing a preset, see “Store a Preset”.

Edit Preset Options
When a preset is stored, it includes a set of Preset Options. In addition to the name of the preset, these 
options define whether the Focus, Exposure, and White Balance settings that are saved with the preset 
can be applied when it is later recalled. The final decision to Allow or Ignore these recall defaults is made 
when the preset is recalled. For more information about how Preset Options are applied, see “About 
Preset Options and Recall Options”.

Important: These options are only applicable when recalling a preset from local storage. For Canon PTZ 
cameras, which do not support local storage, these options are not relevant.
You can edit preset options for any preset button, even if the preset on that button has been deleted, or 
is empty. If you edit Preset Options for a deleted or empty preset button (a gray button), those options 
are presented as defaults when you later store a preset on that button.

To edit the Preset Options for a preset:

1. Tap the preset button for which you want to edit Preset Options.
2. Tap the Edit Preset Options button.

The Edit Options dialog box appears.
3. In the Edit Options dialog box, review and/or modify the Preset Options as follows:

a. In the Preset Name box, type a name for the preset. The name appears on the preset button.

b. Specify whether the Focus, Exposure, and White Balance values stored with the preset can be 
applied when the preset is recalled.

Note: The final decision to Allow or Ignore these defaults is made when the preset is recalled.
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c. Tap Update.

Delete a Preset
When you delete a preset, it can no longer be recalled.

Data about the preset is stored until the preset is restored or discarded. For more information, see 
“Manage Deleted Presets (Restore or Discard)”.

To delete a preset:

1. Tap the preset button that represents the preset you want to delete.
2. Tap the Delete button.

The preset is deleted. The preset button turns gray.

Edit Default Preset Options
When you store a preset, Preset Options are also stored. Depending on the Store Mode, you may or 
may not have an opportunity to review and edit the Preset Options before they are stored with the 
preset. For more information about Store Modes, see “Operation Settings Page”.

You can edit the default values for the Preset Options, which are the values presented for review or 
automatically applied each time you store a preset.

To define the default Preset Options:

1. In the Store Options area, tap the Edit Defaults button.
The Edit Default Preset Options dialog box appears (Figure 46).

Figure 46 - Edit Default Preset Options dialog box

Note: Preset options, except for Default Preset Name, are not shown for the Canon PTZ cameras as 
recall options do not apply when presets are recalled from camera storage.

2. Review and/or modify the default Preset Options as follows:

a. In the Default Preset Name box, type a default name for presets.

b. Specify whether, by default, the Focus, Exposure, and White Balance values stored with the 
preset can be applied when the preset is recalled.

Note: The final decision to Allow or Ignore these defaults is made when the preset is recalled.
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c. Tap Update.

Manage Deleted Presets (Restore or Discard)
When you delete a preset, it can no longer be recalled. Data about the preset is stored until the preset is 
restored or discarded.

To Manage Deleted Presets (Restore or Discard):

1. In the Delete Options area, tap the Manage Deleted Presets button.
The Manage Deleted presets page appears (Figure 47) and displays a button for each of the deleted 
presets on the current bank.

Figure 47 - The Manage Deleted Presets page

2. Select the deleted preset(s) you want to manage.
Tip: If you want to select deleted presets from a different bank, tap that bank button to switch banks.
Tip: If you want to select deleted presets from multiple banks, tap the ALL BANKS button. The 
Manage Deleted Presets page displays all deleted presets from all banks.

3. If you want to restore the selected presets, tap Restore Selected.
4. If you want to permanently discard the selected presets, tap Discard Selected.
5. When you are finished managing deleted presets, tap the X button to close the Manage Deleted 

Presets page.

Working with Presets in Shotbox Mode

This section describes how to work with presets in Shotbox mode. Information presented here applies 
only when the PTZ Camera Control interface is in Shotbox mode (as opposed to Panel mode). For 
information about using the Presets page in Panel mode, refer to “Working with Presets in Panel 
Mode”.
Unless stated otherwise, tasks described in this section are performed from the Presets page.

To access the Presets page, tap the Presets button.

Before you attempt these procedures, we suggest you review the various controls available on the 
Presets page. For a description of these controls, see “Presets Page (in Shotbox Mode)”.
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This section includes information about performing the following tasks in Shotbox mode:
• “Switch Between Banks of Presets”
• “Store a Preset”
• “Recall a Preset”
• “Edit a Preset to Change Camera Position or Settings”
• “Edit Preset Options”
• “Delete a Preset”
• “Edit Default Preset Options”
• “Manage Deleted Presets (Restore or Discard)”

Switch Between Banks of Presets
The PTZ Camera Control plugin can store multiple banks of preset buttons.

Banks are represented by bank tabs above the preset buttons. The current bank tab is always purple.

To switch to a different bank:

• Tap the bank tab representing the desired bank.
The bank tab turns purple, and the presets in that bank are accessible.

Store a Preset
A preset is a record of all controllable axis positions and selected settings for a camera, including pan, tilt, 
focus, zoom, iris, exposure, white balance, etc.

When a preset is stored, it includes a set of Preset Options. In addition to the name of the preset, these 
options define whether the Focus, Exposure, and White Balance settings that are saved with the preset 
can be applied when the preset is later recalled. The final decision to Allow or Ignore these defaults is 
made when the preset is recalled. For more information about Preset Options, see “About Preset 
Options and Recall Options”.

Depending on the current Store Mode, you may be required to review the Preset Options. For more 
information, see “Store Mode”.

Note: For PTZ-12G+, PTZ-12G, and PTZ-NDI cameras, PIVOTCam-SE cameras, Sony BRC cameras, and 
Lumens  PTZ cameras, a preset does not store the on/off status of automatic camera modes, such as 
Auto Focus, Exposure (Full Auto), and White Balance. It stores the actual values for these settings, but 
not the fact that the camera is in an automatic mode. For example, if you save a preset while Auto Focus 
is ON, the focus value is stored but the fact that Auto Focus was ON is not stored. When the preset is 
recalled, the focus value is applied, unless the camera is in Auto Focus mode. Recalling a preset does not 
override automatic mode settings. For Panasonic cameras, Auto Focus mode is not stored, but exposure 
and white balance modes are stored and recalled with presets.

Note: With the Sony ILME-FR7 camera, a preset does not store any information about Exposure or 
White Balance settings. Only Pan, Tilt, Zoom, and Focus are stored. 

Tip: Before you store presets, specify where they are stored and from where they are recalled. For more 
information, see “Specify Where Presets are Stored, and from Where they are Recalled”.

To store a preset:

1. Adjust the camera position and settings to prepare the shot.
2. Tap the Store button to place the interface into Store mode.

The Store button turns yellow.
3. Tap the preset button that you want to use to store the shot.
4. If the Store Preset dialog box appears, review and/or modify the Preset Options as follows:
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a. In the Preset Name box, type a name for the preset. The name appears on the preset button.

b. Specify whether the Focus, Exposure, and White Balance values stored with the preset can be 
applied when the preset is recalled.

Note: The final decision to Allow or Ignore these defaults is made when the preset is recalled.

c. Tap Store.

Recall a Preset
When you recall a preset, its stored pan, tilt, and zoom settings are applied to the camera. Other stored 
settings may also be applied.

To recall a preset:

1. Tap the Recall button to place the interface into Recall mode.
The Recall button turns purple.

2. In the Recall Options area, specify whether to Allow or Ignore the Preset Options for Focus, 
Exposure, and White Balance.
Tip: If Allow and Ignore buttons are not available for an option, it is because the mode/setting listed 
directly below it overrides that option. Recalling a preset does not always override automatic mode 
settings.
For more information about Recall Options, see “About Preset Options and Recall Options”.
Important: Recall options are only applicable when recalling a preset from local storage. For Canon 
PTZ cameras, which do not support local storage, these options are not relevant.

3. Tap the preset button that represents the preset you want to recall.

Edit a Preset to Change Camera Position or Settings
To change the camera position or other settings that are recorded as part of the preset, recall the original 
preset, change the camera position and/or settings as required, and then Store on the same preset 
button.

For information about recalling presets, see “Recall a Preset”.

For information about storing presets, see “Store a Preset”.

Edit Preset Options
When a preset is stored, it includes a set of Preset Options. In addition to the name of the preset, these 
options define whether the Focus, Exposure, and White Balance settings that are saved with the preset 
can be applied when it is later recalled. The final decision to Allow or Ignore these recall defaults is made 
when the preset is recalled. For more information about how Preset Options are applied, see “About 
Preset Options and Recall Options”.

You can edit preset options for any preset button, even if the preset on that button has been deleted, or 
is empty. If you edit Preset Options for a deleted or empty preset button (a gray button), those options 
are presented as defaults when you later store a preset on that button.

To edit the Preset Options for a preset:

1. Tap the Edit Preset Options button to place the interface into Edit Preset Options mode.
The Edit Preset Options button turns green.

2. Tap the preset button for which you want to edit Preset Options.
The Edit Options dialog box appears.
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3. In the Edit Options dialog box, review and/or modify the Preset Options as follows:

a. In the Preset Name box, type a name for the preset. The name appears on the preset button.

b. Specify whether the Focus, Exposure, and White Balance values stored with the preset can be 
applied when the preset is recalled.

Note: The final decision to Allow or Ignore these defaults is made when the preset is recalled.
Important: Recall options are only applicable when recalling a preset from local storage. For 
Canon PTZ cameras, which do not support local storage, these options are not relevant.

c. Tap Update.

Delete a Preset
When you delete a preset, it can no longer be recalled.

Data about the preset is stored until the preset is restored or discarded. For more information, see 
“Manage Deleted Presets (Restore or Discard)”.

To delete a preset:

1. Tap the Delete button to place the interface into Delete mode.
The Delete button turns red.

2. Tap the preset button that represents the preset you want to delete.
The preset is deleted. The preset button turns gray.

Edit Default Preset Options
When you store a preset, Preset Options are also stored. Depending on the Store Mode, you may or 
may not have an opportunity to review and edit the Preset Options before they are stored with the 
preset. For more information about Store Modes, see “Operation Settings Page”.

You can edit the default values for the Preset Options, which are the values presented for review or 
automatically applied each time you store a preset.

To define the default Preset Options:

1. Tap the Store button to place the interface into Store mode.
The Store button turns yellow.

2. In the Store Options area, tap the Edit Defaults button.
The Edit Default Preset Options dialog box appears (Figure 48).

Figure 48 - Edit Default Preset Options dialog box
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3. Review and/or modify the default Preset Options as follows:

a. In the Default Preset Name box, type a default name for presets.

b. Specify whether, by default, the Focus, Exposure, and White Balance values stored with the 
preset can be applied when the preset is recalled.

Note: The final decision to Allow or Ignore these defaults is made when the preset is recalled.

Important: Recall options are only applicable when recalling a preset from local storage. For 
Canon PTZ cameras, which do not support local storage, these options are not relevant.

c. Tap Update.

Manage Deleted Presets (Restore or Discard)
When you delete a preset, it can no longer be recalled. Data about the preset is stored until the preset is 
restored or discarded.

To Manage Deleted Presets (Restore or Discard):

1. Tap the Delete button to place the interface into Delete mode.
The Delete button turns red.

2. In the Delete Options area, tap the Manage Deleted Presets button.
The Manage Deleted Presets page appears (Figure 49), and displays a button for each of the deleted 
presets on the current bank.

Figure 49 - The Manage Deleted Presets page

3. Select the deleted preset(s) you want to manage.
Tip: If you want to select deleted presets from a different bank, tap that bank button to switch banks,
Tip: If you want to select deleted presets from multiple banks, tap the ALL BANKS button. The 
Manage Deleted Presets page displays all deleted presets from all banks.

4. If you want to restore the selected presets, tap Restore Selected.
5. If you want to permanently discard the selected presets, tap Discard Selected.
6. When you are finished managing deleted presets, tap the X to exit the Manage Deleted Presets 

page.



64  •  Working with Presets  User Manual for PTZ Camera Control Plugin

About Preset Options and Recall Options

The PTZ Camera Control plugin has flexible options for managing Focus, Exposure, and White Balance 
values that are recorded as part of a preset.

These options enable you to control how the values are applied. For example, if the lighting conditions 
have changed since a preset was stored, you may not want to apply the stored Exposure values when 
you recall the preset.

When you store a preset, values for Focus, Exposure, and White Balance settings are always recorded. 
For Panasonic cameras, Exposure Modes (auto iris, shutter mode, and AGC) and the White Balance 
Mode are also recorded.

You can specify whether each type of recorded values is a recallable part of the preset, meaning that it is 
made available to be applied when the preset is recalled. The options to make the values available for 
recall are called Preset Options.

When you recall a preset, you can specify whether the Preset Options that were stored with the preset 
are to be Allowed (honored) or Ignored. The options to Allow or Ignore the Preset Options are called 
Recall Options.

Note: These only apply for presets recalled from local storage and not for Canon PTZ.
It is important to note that Recall Options you Allow do not always override automatic camera modes 
when recalling from local:
• If Auto Focus is ON when the preset is recalled, the Focus value stored in the preset is not applied. 

The Auto Focus mode remains active.
• For all supported VISCA cameras (PTZ-12G+, PTZ-12G, and PTZ-NDI, PIVOTCam-SE, Sony BRC, and 

Lumens PTZ cameras), if the Exposure Mode is set to Full Auto when the preset is recalled, the 
Exposure values (Iris, Shutter, Gain) stored in the preset are not applied. The exposure mode 
remains set to Full Auto.

• For Panasonic cameras, the Exposure modes stored with the preset are applied. If a stored mode (Iris, 
Shutter, AGC) is a manual mode, its manual values stored with the preset are applied.

• For all supported VISCA cameras (PTZ-12G+, PTZ-12G, and PTZ-NDI, PIVOTCam-SE, Sony BRC, and 
Lumens PTZ cameras), if White Balance is set to anything other than Manual when the preset is 
recalled, the Color values stored in the preset (Red Gain, Blue Gain) are not applied. The White 
Balance mode remains active.

• For Panasonic cameras, the White Balance mode stored with the preset is applied. If the stored mode 
is a manual mode, the Color values stored in the preset (Red Gain, Blue Gain, and, for the UE160, 
Green Gain) are applied.

Preset Options and Recall Options: An Example
This section presents an example of how Preset Options, Recall Options, and automatic camera modes 
can affect how recorded Focus, Exposure, and White Balance values are applied.

This example is based on PTZ-12G+, PTZ-12G, and PTZ-NDI cameras, and recalling from local.

Figure 50 shows a set of Preset Options, which are specified when the preset is stored. In this example, 
Recall Exposure and Recall White Balance are selected. Recall Focus is not. When the preset is 
recalled, the recorded Focus value will not be available for recall.
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Figure 50 - Preset Options, stored as part of a preset

Figure 51 shows a set of Recall Options, which are specified immediatelybefore the preset is recalled. 
Focus and White Balance are set to Allow. The Exposure Recall Option is not available, because the 
Exposure Mode for the camera is set to Full Auto.

Figure 51 - Recall Options, specified immediately before preset recall

The combination of Preset Options in Figure 50 and Recall Options in Figure 51 would result in the 
following:
• The Focus value is not applied because the Focus preset option was not selected when the preset was 

stored.
• The Exposure values (Iris, Shutter, Gain) are not applied because the camera setting for Exposure 

Mode is set to Full Auto.
• The stored Color values (Red Gain, Blue Gain) are applied because the camera’s White Balance 

Mode is set to Manual, and White Balance was selected as a Preset Option and Allowed as a Recall 
Option.
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Managing Banks and Files
A bank is a grid of preset buttons, each of which represents a camera preset. The PTZ Camera Control 
plugin can store multiple banks of preset buttons. You can configure the banks to suit your 
requirements. For more information, see “Managing Banks”.

A camera settings file (.camera file) contains data about camera settings, banks, and presets. You can 
import or export .camera files. For more information, see “Managing Files”.

Managing Banks

This section includes the following topics:
• “View Edit Bank Properties and Edit Bank Settings (ALL BANKS)”
• “Add a New Bank”
• “Remove a Bank”
• “Rebuild Banks”
• “Discard All Presets on a Bank, or Discard All Presets”
• “View and Edit Preset Options for All Presets on a Bank”

Note: All procedures in this section are performed from the Manage Banks page.

To access the Manage Banks page:

1. Tap the Presets button.
The Presets page opens.

2. Tap the Manage Banks button.
The Manage Banks page appears (Figure 52).

Figure 52 - Manage Banks page, showing the ALL BANKS tab

To close the Manage Banks page:

• Tap the X button.
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View Edit Bank Properties and Edit Bank Settings (ALL BANKS)
To view bank properties and edit their settings:

1. On the Manage Banks page, tap the All BANKS button.
A table of bank properties and settings appears.

2. View and edit the following properties and settings as required:
• Bank ID — Unique identifier for the bank identifier (not editable).

On the Presets page, banks appear in the order of their Bank IDs. If you create a new bank, it is 
assigned the lowest available Bank ID.

• Bank Name — The name of the bank (editable). Bank name appear on bank tabs on the Presets 
page.

• Presets — The number of presets the bank can store (not editable).
• First Preset ID — The Preset ID number of the lowest-numbered preset on the bank (not 

editable). Each preset has a unique Preset ID, regardless of which bank it’s on. A preset retains its 
Preset ID, even if lower numbered banks are removed.

• Stored Presets — The number of stored (recallable) presets on the bank (not editable). This 
number does not include deleted or empty presets.

• Bank Format — The display format for text that appears on preset buttons.
Available formats are as follows:
› number only — Preset ID number only
› name only — Preset Name only
› name & number, 1 line — Preset ID and Preset Name, all on one line
› name & number, 2 lines — Preset ID on one line and Preset Name on another

• Text size for preset name — Font size for text that appears on preset buttons. (editable).
The size range is 4 to 20.

Add a New Bank
Note: For Canon PTZ cameras, only 100 presets are supported. If you try to add a bank which will take 
you over that 100 preset limit, you will get a warning and the add bank will fail.
To add a new bank:

1. On the Manage Banks page, tap the All BANKS button.
A table of bank properties and settings appears, with a row of buttons beneath it.

2. Tap the Add Bank button.
The Add Bank dialog box appears.

3. Specify the following:
• Bank Name — The name of the bank, as you want it to appear on its Bank tab on the Presets 

page.
• Bank Format — The display format for text that appears on preset buttons.

Available formats are as follows:
› number only — Preset ID number only
› name only — Preset Name only
› name & number, 1 line — Preset ID and Preset Name, all on one line
› name & number, 2 lines — Preset ID on one line and Preset Name on another

• Text Size — Font size for text that appears on preset buttons. The size range is 4 to 20.
4. Tap OK.

The Manage Banks page closes, and on the Presets page, a new tab for the bank appears.
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Remove a Bank
When you remove a bank, the bank tab and all presets on it are permanently discarded.

To remove a bank:

1. On the Manage Banks page, tap the All BANKS button.
A table of bank properties and settings appears, with a row of buttons beneath it.

2. In the table, tap the row representing the bank you want to remove.
3. A WARNING message appears.

The message indicates how many presets are stored on the bank. All presets will be permanently 
discarded if you remove the bank.

4. In the WARNING message box, tap Discard to permanently discard the bank and its presets.

Rebuild Banks
A bank is a grid of preset buttons, each of which represents a camera preset. The PTZ Camera Control 
plugin can store multiple banks of preset buttons.

When you rebuild banks, you specify how many banks there are and how many rows and columns of 
preset buttons are on each bank. When rebuilt, all banks are identical.

When you rebuild banks, all existing banks and presets are permanently discarded. If you want to retain 
the current banks and presets for future use, save them in a camera settings (.camera) file. For more 
information, see “Save (Export) Banks, Presets, and Camera Settings (.camera file)”.

Before you can rebuild banks, all existing banks must be empty. You can discard all presets at once. For 
more information, see “Discard All Presets on a Bank, or Discard All Presets”.

Note: For Canon PTZ cameras, only 100 presets are supported. If you try to configure the bank rows, 
columns or number of banks so that the total number of presets would exceed 100, your change will be 
rejected and a warning message shown.
To rebuild banks:

1. Tap the Presets button.
The Presets page opens.

2. Tap the Manage Banks button.
3. Tap the Rebuild Banks button.
4. If a WARNING message appears, one or more banks are not empty. Delete or discard all presets, 

and then start this procedure again.
For information about discarding all presets at once, see “Discard All Presets on a Bank, or Discard 
All Presets”.

5. In the Rebuild Banks dialog box, specify the following properties for the new banks:
• Number of Banks: The number of bank tabs (banks) to create.

Tip: You can add more banks later. For more information, see “Add a New Bank”.
• Bank rows and Bank columns: These two settings define the size of the preset banks (grids), 

expressed as the number of buttons tall (Bank rows) and the number of buttons wide (Bank 
columns) the rectangular grid is.

• Bank Format: The display format for text that appears on preset buttons.
Available formats are as follows:
› number only — Preset ID number only
› name only — Preset Name only
› name & number, 1 line — Preset ID and Preset Name, all on one line
› name & number, 2 lines — Preset ID on one line and Preset Name on another

• Text Size — Font size for text that appears on preset buttons. The size range is 4 to 20.
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• Preset Number Display Offset — Specify whether the lowest-numbered Preset ID should be 0 
or 1. This is an aesthetic choice; changing between 0 and 1 does not change how presets are 
stored in DashBoard or on the camera. For more information, see “Preset Number Display 
Offset”, which is within the section, “Operation Settings Page”.

6. Tap OK.
The existing preset banks are permanently removed, and a new set of preset banks is created.

Discard All Presets on a Bank, or Discard All Presets
You can discard all presets on a bank at once.

Alternatively, you can discard all presets on all banks at once.

After you discard presets, they cannot be restored.

Note: Presets are discarded locally only. If the presets are stored on the camera, they are not deleted 
from the camera.

To discard all presets on a bank:

1. On the Manage Banks page, tap the All BANKS button.
A table of bank properties and settings appears, with a row of buttons beneath it.

2. In the table, tap the row representing the bank that contains the presets you want to discard.
3. Tap the Discard All button.

A WARNING message appears. The message indicates how many presets are stored on the bank. If 
you proceed, all presets on the bank will be permanently discarded.

4. In the WARNING message box, if you want to retain the Preset Options settings on the preset 
buttons, select the Preserve preset options box.

5. Tap Discard.

To discard all presets on all banks:

1. On the Manage Banks page, tap the All BANKS button.
A table of bank properties and settings appears, with a row of buttons beneath it.

2. Tap the Discard All on Camera button.
A WARNING message appears. If you proceed, all presets on all banks will be permanently 
discarded.

3. In the WARNING message box, if you want to retain the Preset Options settings on the preset 
buttons, select the Preserve preset options box.

4. Tap Discard.

View and Edit Preset Options for All Presets on a Bank
You can view the Preset Options for all the presets on a bank at once. You can also edit them.

To view and edit Preset Options:

1. On the Manage Banks page, tap a bank button.
A table listing the bank’s presets appears, listing the Preset Options for each (Figure 53).
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Figure 53 - Manage Banks page, showing recall settings for individual presets

2. In the table, tap the row representing the preset you want to edit.
3. Edit the Preset Options as required:

a. In the Preset Name box, type a name for the preset. The name appears on the preset button.

b. Specify whether the Focus, Exposure, and White Balance values stored with the preset can be 
applied when the preset is recalled.

Note: The final decision to Allow or Ignore these defaults is made when the preset is recalled.

Managing Files

The PTZ Camera Control plugin can save (export) and load (import) camera settings files (.camera files). 
These files contain data about preset banks, camera settings, and presets.

This section describes how to import and export data from and to camera settings files. It includes the 
following topics:
• “Load (Import) Banks, Presets, and Camera Settings (.camera file)”
• “Save (Export) Banks, Presets, and Camera Settings (.camera file)”

Load (Import) Banks, Presets, and Camera Settings (.camera file)
When you load a camera settings (.camera) file, current camera settings, banks, and presets are 
permanently discarded and replaced.

IMPORTANT: The .camera file you load must contain data for the same model of camera. If you load a 
.camera file that contains data for a different model of camera, the import fails.

To load (import) a camera settings (.camera) file:

1. On the Manage Banks page, tap the All BANKS button.
A table of bank properties and settings appears, with a row of buttons beneath it.

2. Tap the Import button.
The Import Camera Settings dialog box appears.

3. Tap the Browse button.
The Open File dialog box appears.
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4. Navigate to the .camera file you want to load, select it, and then tap Open.
The name of the file appears in the yellow box on the Import Camera Settings dialog box.

5. Tap Import.
If the file is valid, it is imported.

Save (Export) Banks, Presets, and Camera Settings (.camera file)
When you save (export) a camera settings (.camera) file, current camera settings, banks, and presets are 
copied to the file. You can later load (import) the file when configuring any camera of the same model.

To save (export) a camera settings (.camera) file:

1. On the Manage Banks page, tap the All BANKS button.
A table of bank properties and settings appears, with a row of buttons beneath it.

2. Tap the Export button.
The Export Camera Settings dialog box appears.

3. Tap the Save button.
The Save File dialog box appears.

4. Navigate to the folder where you want to save the file, and then do one of the following:
• If you are replacing an existing file, select it.
• If you are saving the file with a new name, in the File Name box, type the file name.

5. Tap Save.
6. If a Replace File dialog box appears, asking you whether you want to replace an existing file, tap Yes.

The Confirm File Replace dialog box appears. Tap Yes.
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Adding USB Joysticks or Other 
USB Controllers
This section describes how to set up a USB joystick or other USB controller to select and control 
supported PTZ cameras, in conjunction with the DashBoard PTZ Camera Control plugin.

Camera functions that can be controlled by a USB controller fall into three groups; camera selection, 
camera motion (pan, tilt, zoom, and focus), and paintbox controls (lens iris and shading/paint controls). 
Depending on the USB controller(s) available, you can control all functions with a single controller, or add 
a separate controller for each group of functions.

You can also configure otherwise unassigned buttons on the controller to open DashBoard device views 
or panels.

The main steps are as follows: 

• “Add a USB Controller in DashBoard”
• “Add Device Classes, and Map Controls to Parameters”
• “Map Device Classes to Controllers”
• “Configure Relationship Between Camera Selection and UI Focus”
• “Map Buttons for Camera Selection”

Add a USB Controller in DashBoard
To add a USB controller to control PTZ cameras:

1. Close DashBoard.
2. Plug the USB controller into a USB port on the DashBoard computer.
3. Start DashBoard.

When DashBoard starts, it detects the controller.
Tip: DashBoard can detect the controller only if the controller is plugged in when DashBoard starts.

4. In DashBoard, on the File menu, select New, and then select Other.
The New dialog box appears (Figure 54 -).
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Figure 54 - Adding a USB controller

5. In the Wizards list, expand Input Devices, select New Game Controller, and then tap Next.
The New Game Controller Connection dialog box appears (Figure 55).

Figure 55 - Connecting to a USB controller

6. In the Display Name box, type a name for the controller.
7. In the Controller list, select the type of USB controller you plugged in.

Note: If the controller type is not on the list, either it was not detected or it is already registered in 
DashBoard.
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8. Click Finish.
A node for the controller appears within the Game Controllers node in the DashBoard Component 
Tree. The node has the name you provided for the controller.

Add Device Classes, and Map Controls to Parameters

A USB controller typically has buttons and axis controls. A button is either on or off, and therefore 
returns one of two data values. An axis control, such as a joystick, can return any value within a range of 
data values, depending on how far the joystick is moved in one direction or the other.

You can configure each axis control on the USB controller to operate a robotic axis, or operate a control 
that accepts a continuous range of data values, such as a Master Black paint control.

Additionally, you can configure buttons to return single values. For example, if you often want to pan 
right or left at half speed, you can configure one button to return a value of -50 while pressed, and 
another to return a value of 50 (pan axis range is -100 to 100).

This section describes how to map a wide variety of commonly-used axis controls and button controls. 
You can decide which controls you want to map, based on your preferences and the available physical 
controls on your USB device(s).

To add device classes, and map controls to DashBoard parameters (OIDs):

1. In the DashBoard Component Tree, expand the Game Controllers node, and then double-tap the 
controller node you added.
The configuration interface for the controller appears (Figure 56). The ptzjoystick Device Class is 
present by default.

Figure 56 - Mapping USB controller inputs (shown with Device Classes added and OIDs mapped)
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Tip: The number and types of axis controls and buttons vary between different models of USB 
controllers.

2. In the Device Classes list, add a new device class and name it paintbox.
3. In the Device Classes list, add a new device class named selector.
4. In the Axis Controls table, create mappings for the velocity parameters that you want the USB 

controller’s axis controls (such as joysticks) to operate.
When you create mappings, you link data items reported by the controller to parameters (OIDs) in 
the PTZ Camera Control plugin.
Tip: To determine which Axis Controls and Buttons correspond to physical controls on the 
controller, move the controller’s joystick and push its buttons while observing changes in the Value 
column.

Relevant columns in the Axis Controls mapping table are as follows:
• ID — The ID of the control, as reported by the controller. This is not configurable.
• Name — You can name each control for future reference (optional).
• Min and Max - Defines the range of data values sent to the DashBoard parameter. When the 

control is in a neutral position, the data value is halfway between Min and Max. For example, if 
Min is -100 and Max is 200, the neutral value is 50.

Tip: DashBoard automatically scales the data value to suit the data range of the associated 
parameter. You do not need to match Min and Max to the lowest and highest parameter 
values.

• Speed% — Scales the data values, to make them change more or less gradually. For example, if 
you use a joystick to control a paint velocity parameter such as 
paintbox.vel.whitebalance.gain.r, you might set Speed % to 10. When you push the joystick all 
the way, the value changes at one-tenth the default rate. This enables you to see the effect more 
easily as you change the value.

• Sensitivity — Defines the number of steps between each end of the data range and the 
controller’s neutral position. For example, if Min is -100, Max is 100, and Sensitivity is 20, then the 
value changes by increments of 5. The range of values starts at -100 (-100, -95, -90, etc.) and 
continues to 100.

• Invert — When selected, reverses the direction of joystick motion required to move the axis. For 
example, if the camera is ceiling mounted, select Invert for pan and tilt so when you move the 
joystick, the camera moves as desired.

• Value — Shows the current data value reported by the controller. This is useful for testing.
• Mapped OID — Specify the parameter OID from the PTZ Camera Control plugin to be mapped to 

the control.

Table 1 lists parameters that are commonly mapped to axis controls.
Table 1 - - Parameters that are commonly mapped to axis controls

Parameter (Mapped OID) Description

ptzjoystick.vel.tilt Tilt axis velocity

ptzjoystick.vel.pan Pan axis velocity

ptzjoystick.vel.zoom Zoom axis (lens zoom) velocity

ptzjoystick.vel.focus Focus axis (lens focus) velocity

paintbox.vel.shutter.preset Shutter control velocity

paintbox.vel.iris.control Iris axis (lens iris) velocity

paintbox.vel.whitebalance.gain.b Blue Gain paint control velocity

paintbox.vel.whitebalance.gain.r Red Gain paint control velocity
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5. In the Buttons table, create mappings for the parameters that you want the USB controller’s buttons 
to operate.
When you create mappings, you link data items reported by the controller to parameters (OIDs) in 
the PTZ Camera Control plugin.
Tip: To determine which Axis Controls and Buttons correspond to physical controls on the 
controller, move the controller’s joystick and push its buttons while observing changes in the Value 
column.
For an example showing the Buttons mapping table completed, see Figure 56 on page 74,

Relevant columns in the Buttons mapping table are as follows:
• ID — The ID of the control, as reported by the controller. This is not configurable.
• Name — You can name each control for future reference. (optional).
• Action — The type of action to be performed when the button is pressed.
• Value (Off) — This is the value of the parameter when the button is not pressed.
• Value (On) — This is the value of the parameter when the button is pressed.
• Value — Shows the current data value reported by the controller. This is useful for testing.
• Mapped OID — Specify the parameter OID from the PTZ Camera Control plugin to be mapped to 

the control.
Tip: If you are configuring multiple controllers and dividing the control functions among them, the 
controls within each device class must be assigned to a single controller. The name of each 
parameter OID starts with the name of its device class (selector, ptzjoystick, or paintbox).
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Table 2 lists parameters that are commonly mapped to button controls.
Note: The values required for some mappings may vary between camera models.

Table 2 - - Parameters that are commonly mapped to button controls

Parameter (Mapped OID) Description

selector.selection Camera selection, for systems that include multiple cameras. Map 
this parameter to a set of buttons to be used for selecting the 
camera to be controlled. Each row in the Buttons table 
corresponds to a button on the controller.

For each button you want to assign as the selector for a camera, 
do the following:

• In the Name column, assign a camera name for future 
reference (optional).

• Set Action to Set Value.
• Set Value (Off) to -1
• Set Value (On) to a unique camera ID number (For example, 0, 

1, 2, 3, etc.). The actual ID number is arbitrary. Note the camera 
ID numbers. You will later map this ID number to the camera’s 
remote control DashBoard interface.

ptzjoystick.focus.auto_on Auto focus mode.

Configure a button to toggle auto focus on and off.

To map ptzjoystick.focus.outo_on:

• Set Action to Toggle.
• Set Value (On) to 2.
• Set Value (Off) to 3.

ptzjoystick.focus.onepush.trigger Enables a button on the controller to perform a one-time auto 
focus.

To map ptzjoystick.focus.onepush.trigger:

• Set Action to Set Value.
• Set Value (Off) to 0.
• Set Value (On) to 1.

Note: Focus mode must be set to One Push Auto Focus. For 
more information, see “Focus Controls”.

paintbox.autoexposure.mode Auto exposure mode.

Configure a button to toggle between values for two modes:

0 — Full Auto mode

3 — Manual mode

10 — Shutter Priority mode

11 — Iris Priority mode

To map paintbox.autoexposure.mode:

• Set Action to Toggle.
• Set Value (Off) to the value for one mode.
• Set Value (On) to the value for another mode.

For more information about auto exposure modes, see 
“Exposure Controls”.
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paintbox.whitebalance.mode White balance mode.

Configure a button to toggle between values for two modes:

0 — Auto mode

3 — One Push mode

5 — Manual mode

To map paintbox.whitebalance.mode:

• Set Action to Toggle.
• Set Value (Off) to the value for one mode.
• Set Value (On) to the value for another mode.

For more information about white balance modes, see “Color 
Controls”.

paintbox.whitebalance.onepush.trigger White balance one-push trigger.

To map paintbox.whitebalance.onepush.trigger:

• Set Action to Set Value.
• Set Value (Off) to 0.
• Set Value (On) to 1.

Note: White balance mode must be set to One Push. For more 
information, see “Color Controls”.

paintbox.shutter.preset Shutter control. Configure one button to increase the value and 
another to decrease it:

• For both buttons, set Action to Increment.
• For the button that increases the value, Set Value (On) to 1, 

and set Value (Off) to 0.
• For the button that decreases the value, Set Value (On) to -1, 

and set Value (Off) to 0.

paintbox.iris.control Iris control. Configure one button to increase the value and 
another to decrease it:

• For both buttons, set Action to Increment.
• For the button that increases the value, Set Value (On) to 1, 

and set Value (Off) to 0.
• For the button that decreases the value, Set Value (On) to -1, 

and set Value (Off) to 0.

paintbox.whitebalance.gain.b

paintbox.whitebalance.gain.r

Green Gain paint control (paintbox.whitebalance.gain.g), Blue 
Gain paint control (paintbox.whitebalance.gain.b), and Red Gain 
paint control (paintbox.whitebalance.gain.r).

For each of these three parameters, configure one button to 
increase the value and another to decrease it:

• For both buttons, set Action to Increment.
• For the button that increases the value, Set Value (On) to 1, 

and set Value (Off) to 0.
• For the button that decreases the value, Set Value (On) to -1, 

and set Value (Off) to 0.

camera.wiper

camera.washer

Wiper (camera.wiper) and Washer (camera.washer) controls.

For each parameter, configure a button:

• Add device class “camera”.
• Set Action to Set Value.
• Set Value(On) to 1 and set Value (Off) to 0.

Note: The washer moves 4 times with every use.

Table 2 - - Parameters that are commonly mapped to button controls

Parameter (Mapped OID) Description
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6. If you want to save the mappings in a file that can be loaded onto other DashBoard computers, click 
the SAVE button and specify a file name and path.
Note: The mappings are specific to the controller(s) you configured. You can use the mappings on 
other DashBoard computers only if their controllers are the same model, or report the exact same 
controls.
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Map Device Classes to Controllers

Camera functions that can be controlled by a USB controller fall into three groups; camera selection, 
camera motion (pan, tilt, zoom, and focus), and paintbox controls (lens iris and shading/paint controls). 
Depending on the USB controller(s) available, you can control all functions with a single controller, or add 
a separate controller for each group of functions.

To map device classes to one or more controllers:

1. In the Component Tree, within the DashBoard Services node, double-tap Device Class Mappings.
The Device Class Mappings interface appears (Figure 57 -).

Figure 57 - Device Class Mappings for a USB controller

2. If you plan to use the controller to adjust lens iris, in the paintbox row set Selected Device to the 
controller you are configuring.
Tip: If a class you want to map is already mapped, click Clear Selection and then map it to the 
controller.

3. If you plan to use the controller to move cameras (pan, tilt, zoom, focus), in the ptzjoystick row set 
Selected Device to the controller you are configuring.

4. If you plan to use buttons on the controller to select cameras in the PTZ Camera Control plugin, in 
the selector row set Selected Device to the controller you are configuring.

Configure Relationship Between Camera Selection and UI 
Focus

You can configure how the user interface interacts with the controller, to achieve your choice of the 
following options:
• The controller can select and control cameras ONLY IF PTZ Camera Control is the active DashBoard 

application (in focus).
• The controller can controller to select and control cameras regardless of what DashBoard application 

is active (in focus).
• If a controller button configured to open a device view or panel is pushed, that device view or panel 

becomes active (in focus)
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To configure the relationship between camera selection and UI focus:

1. In the Component Tree, expand the DashBoard Services node, and then double-tap Selector UI 
Mappings.
The Selection Mapping interface appears (Figure 58).

Figure 58 - UI Follow and Autowire settings

2. Choose one of the following options and tap the corresponding button:
• Autowire Follows UI ON

If you select this option, you cannot use the controller to select and control cameras unless 
the PTZ Camera Control plugin is the active DashBoard application (in focus).
This option helps prevent accidental movement of cameras while the operator is using other 
DashBoard panels or device views. It also ensures that the PTZ Camera Control plugin is 
always readily available while you are controlling cameras.

• UI Follows Selection OFF
If you select this option, you can use the controller to select and control cameras regardless 
of which panel or device view is active (in focus).
This option enables you to use the PTZ Camera Control plugin and other DashBoard panels 
or device views for other tasks while you use the controller to select and control cameras.

• UI Follows Selection ON
If you select this option, whenever a configured button opens a DashBoard panel or device 
view, that panel or device view becomes active (in focus). If the PTZ Camera Control plugin is 
active and you press a controller button to open a different panel or a device view, the PTZ 
Camera Control plugin loses focus.
Use this option if you want to configure otherwise unassigned controller buttons to open 
DashBoard panels and device views on demand, such as Carbonite control, or the PTZ 
Camera Control plugin.



82  •  Adding USB Joysticks or Other USB Controllers  User Manual for PTZ Camera Control Plugin

Map Buttons for Camera Selection

This procedure applies if your system has multiple cameras and you want to configure controller buttons 
to select them.

To map camera selector buttons:

1. In the Selection Mapping interface (Figure 59), tap the Add Mapping button.
A new mapping row appears in the Selection Mapping table.

Figure 59 - Mapping cameras to camera selector buttons

2. In the new mapping, set ID to the camera ID number for a camera. Each mapping requires a unique 
ID.
Tip: You defined the camera ID numbers as Value on settings for buttons, in a previous procedure 
(“Add Device Classes, and Map Controls to Parameters”).

3. Specify a Name for the mapping (optional).
4. For UI Primary Identifier, navigate to Remote Control for the camera to be selected.
5. Repeat the preceding steps for each camera selector button you want to configure.
6. If you want to save the mappings in a file that can be loaded onto other DashBoard computers, click 

the SAVE button and provide a file name and path.
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